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A. Introduction 
The DTS Editor allows you to view terminology content stored in Ontylog, Ontylog Extension 

and Thesaurus namespaces within your knowledgebase (in DTS each namespace represents a 

separate source terminology). Each namespace is either subscription (provided by Apelon as 

part of its Content Subscription Service) or local, created by you. All of your namespaces 

together comprise your knowledgebase. You can configure a tree display for a broad view of a 

selected subscription namespace, then select an individual item (e.g., concept, term) for which to 

view detailed information.  

The edit functions in the DTS Editor allow you to create and maintain new content in one or 

more local Ontylog Extension and Thesaurus namespaces. Each user-defined local namespace 

that you create can contain new concepts and/or terms that reside outside of any of your 

subscription namespaces.  

In the local namespace you also can map relationships (i.e., create associations) between 

selected concepts or terms in your local content, and specific concepts or terms in subscription 

namespace content. For example, you can create a mapping between a single concept in an 

Ontylog subscription namespace, such as SNOMED CT, and a newly created concept in your 

local Chief Complaint namespace.  

A.1 Namespaces 

A.1.1 Subscription Ontylog Namespaces 
An Ontylog namespace is one created using the Ontylog language, usually developed using 

Apelon’s Terminology Development Environment (TDE) product. TDE, and Ontylog, allow you 

to build and maintain knowledgebases through the use of description logic. Concepts and terms 

in Ontylog are organized into a taxonomy through a process called classification. Subscription 

Ontylog Namespaces are “Read-Only” in the DTS Editor and cannot be modified.  Refer to the 

Ontylog Namespaces discussion later in this guide for more on Ontylog namespaces.  

 

A.1.2 Local Ontylog Namespace 
A Local Ontylog Namespace is one created locally using the DTS Editor tool.  Similar to a 

Thesaurus namespace, but utilizing the Ontylog language.  These namespaces are not inherently 

“Read-Only”, as Subscription Ontylog Namespaces are, and can be edited using the DTS Editor 

tool locally, before being classified and published. 

A.1.3 Ontylog Extension Namespaces 
Since you cannot perform edits directly to a Subscription Ontylog-type namespace using the 

DTS Editor. Using the DTS Editor, instead you can (locally) create new concepts and concept 

relationships for each Subscription Ontylog namespace by creating an Ontylog Extension 

namespace.  

 

You link the Ontylog Extension local namespace to the specific Subscription Ontylog namespace 

for which you want to add or modify content. Each Extension namespace is comprised of 

supplemental content that you create locally, content that you can classify against the linked 

Subscription Ontylog content.  
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Classification of a namespace produces the namespace’s inferred view, which takes concept and 

role relationships into account. If necessary, classification positions concepts in the namespace 

hierarchy based on these relationships.  

You may link each Extension namespace to only a single Subscription Ontylog namespace. You 

can, however, create multiple Extension namespaces that link to the same Subscription Ontylog 

namespace.  

Refer to the DTS Classification Guide for procedures on creating and classifying Ontylog 

Extension namespaces. 

A.1.4 Thesaurus Namespaces 
A Thesaurus namespace in DTS is one in which concepts and terms are organized based on 

relationships (associations) with other concepts. The DTS Editor provides view capabilities for 

subscription namespaces with the type of Thesaurus. You can create a new “local” namespace 

that is a Thesaurus type. In the local namespace you can create new content, and establish 

mappings to content in subscription namespaces (both Ontylog and Thesaurus) as well as other 

local namespaces. Refer to the Thesaurus Namespaces discussion later in this guide for more on 

Thesaurus namespaces.   

A.1.5 Subsets  
A subset is an arbitrary collection of concepts. It may represent concepts that share a specific set 

of attributes, or simply are commonly used in a well-defined context. A subset may include only 

a few concepts or many concepts. The term value-set is an alternate name for subset. The 

concepts in a subset may be derived from one or more than one namespace, or they can be 

defined by their participation in other subsets.  

Using the Subset Editor functions available to you from the DTS Editor Main window, you can 

create and maintain subsets. If the namespace you are viewing in the DTS Editor has one or more 

subsets created for it, you can highlight each concept in the view that was selected for a subset. 

Refer to the Subsets discussion later in this guide for procedures on subset creation and 

maintenance in DTS.  

 

A.2 Purpose of This Guide 
This guide includes procedures for using the view capabilities in the DTS Editor to create tree 

views of subscription content in Ontylog and Thesaurus namespaces. Detail views are available 

for each selected concept/term in a tree view. Illustrations of different view scenarios are 

provided.  

The guide also includes procedures for adding and maintaining one or more local namespaces, as 

well as the new content within. This content includes new concepts and/or terms, and the 

attributes related to each (e.g., properties, associations). Procedures for creating new associations 

between concepts and/or terms within a namespace are provided, as well as procedures for 

creating associations across namespaces. Illustrated examples are included.  

  

http://www.apelondts.org/Downloads/Documentation/tabid/137/Default.aspx
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A.3 DTS Editor High Resolution Compatibility 
The DTS Editor may experience display issues on high resolution screens. To fix these display 

issues, follow these steps. 

1. Go to <DTS Home>\java\jre\bin and find the java.exe and javaw.exe files. For each file, 

perform the following. 

2. Right-click on the file and select Properties 

3. Go to Compatibility tab 

4. Click Change high DPI settings 

 
 

5. Check the Override high DPI scaling behavior checkbox 

6. In the Scaling performed by dropdown, select System 
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A.4 Start the DTS Editor 
Start the DTS Editor from the Windows Start menu (Start >Programs > Apelon DTS 4.5 > 

DTS Editor) or similar method appropriate for your installation. The DTS Editor start-up 

window is shown: 

 

 
 

This window allows you to establish a connection to the DTS server. Once the connection has 

been made, your default Editor Layout (configuration) for this server will be loaded and you can 

begin work on the DTS knowledgebase. 

 

In the sections that follows, we will assume that your default Layout is the standard DTS Editor 

Layout. The Editor Layout can be customized to meet individual user or organization needs. See 

the DTS Editor Module Guide for information on creating and establishing alternate Editor 

Layouts. 

 

Note: If you create a new Layout that does not have the Layout Select menu item and then set 

this Layout as your default User Layout, this Layout will be loaded when you connect and you 

will not be able to access any other Layout. DTS provides an escape for this situation. Follow 

these steps to force a load of the standard DTS Editor Layout: 

 

1. Close and restart the Editor. 

2. Press and hold the Ctrl and Alt keys on your keyboard. 

3. Click Connect from the File menu. 

A.4.1 Connection Parameters 
Follow this procedure to establish a connection to the DTS server.  

 

Confirm that an Apelon DTS Application Server is running and a User has been created prior 

to starting the Editor. 

 

http://www.apelondts.org/Downloads/Documentation/tabid/137/Default.aspx
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Select Connect Parameters from the File menu. The Connect Parameters window appears. 

 

 
 

Host: Enter your Host name (for the machine where your Application Server is running) i.e., 

localhost 

Port: Enter the Port number to access the DTS Server, i.e., 4447 

Instance: Enter the Instance name of the DTS Server file on your Application Server, i.e., 

dtsjboss 

Username: Enter the Username for a created DTS User to access the DTS Server, i.e., 

dtsadminuser 

Password: Enter the Password for a created DTS User to access the DTS Server, i.e., dtsadmin 

 

To recall these values for future sessions, check Use these values as defaults.  

To automatically connect on start up with the saved credentials, check Auto-connect on start-up. 

Click Connect to establish connection to your DTS Server.  

If this is the first time you have logged in to the Editor, the Content License Agreements window 

displays.   

A.4.2 Content License Agreements 
The first time you log into the DTS Editor, the Content License Agreement(s) window displays 

immediately after you establish your database connection. This window shows the applicable 

license agreements for any proprietary terminologies in your DTS Knowledgebase. 
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In order to use the DTS Editor, use the Scroll Bar to view license terms for all of the 

vocabularies to which you subscribe. Click Yes (which is enabled after you read the entire 

agreement) to accept the terms; the DTS Editor Main window redisplays. 

Once you have accepted these agreements, the Content License Agreement(s) window will not 

appear again on login until new proprietary sources (or new versions) are added to your 

knowledgebase. 

 

A.5 Connect to the DTS Editor 
Once the connect parameters have been set up as described above, you can subsequently connect 

to the DTS Server by simply selecting Connect from the File menu, or clicking on the toolbar 

Connect icon . These actions will perform an automatic connect using the existing (saved) 

connection parameters.  

 

A.6 Disconnect From the DTS Editor 

Select Disconnect from the File menu, or click the toolbar Disconnect icon . If there is 

unsaved data (new or modified) in one of the DTS Editor components, the following 

confirmation window displays. 
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Click OK to close the component and disconnect without reviewing or updating unsaved data; 

displayed floating panels are closed when you disconnect. Click Cancel to disregard the 

disconnect request.  
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B. The DTS Editor Main Window 
As soon as you complete the connection to the DTS server, your default DTS Editor Layout is 

loaded and the DTS Editor main window displays. The DTS Editor version number displays in 

the window header. The window consists of two main display panels. The panels available in the 

left pane of the window relate to global navigation and viewing tasks.  

When the window first opens, the Tree tab is selected and the Concept Tree panel displays in the 

left pane. This panel will contain the “trees” association with all the available namespaces in 

your knowledgebase. The entry in the Namespace dropdown will be “- All -“ . If you select a 

specific namespace from the Namespace dropdown field, this tree displays the concept hierarchy 

for the selected namespace in the knowledgebase.  

 

 
 

You can navigate through the concept tree by clicking on the Expand  icon next to any entry. 

The Details tab panel displays in the right pane. Here, you may view concept details, term 

details, namespace details, subset details, and authority details by selecting the associated tab. By 

using this panel, you can also add new concepts, terms, namespaces, subsets, and authorities and 

edit their attributes locally. Each of these tab panels is discussed in more detail later in the guide. 

The Status Bar located at the bottom of the window indicates whether or not you are connected 

to the database.  

 

 
 

The Windows Text Edit functions Cut, Copy, and Paste are available in many of the DTS 

Editor data fields through keyboard shortcuts (CTRL-X, CTRL-C, and CTRL V, respectively). 
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The captured values of Cut can also be customized. See the Set Clipboard Formats description 

below for further information. 

 

B.1 Modify Main Window Panel Sizes 
You can modify the display by clicking and dragging the edge of the pane you want to resize. 

Note the resized panes in the following illustration. 

 

 

The resized panel settings are retained if you disconnect from the DTS Server, then reconnect. 

 

B.2 DTS Editor Main Window Menu Options 

B.2.1 File Menu 
Connect - Establishes your connection to the DTS Server and the knowledgebase (you also can 

click the Connect icon  in the toolbar). 

Connect Parameters - Displays connection parameters on the Connect Options window. 

Disconnect - Disconnects you from the DTS Server and the knowledgebase (you also can click 

the Disconnect icon  in the toolbar).  

Exit - Ends this DTS Editor session and exits the program. 
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B.2.2 Tools Menu 
Concept Tree - Displays the Concept Tree panel as a floating window (you also can click the 

Open New Tree icon in the toolbar). Use this window in addition to the Concept Tree panel, 

which you can display by clicking the Tree tab in the left pane.  

 

Search - Lets you open the Search panel as a separate window (you also can click the Search 

icon in the toolbar). The Search panel allows you to search for a concept based on the parameters 

you specify. Use this window as an alternative to the Search panel, which you can display by 

clicking the Search tab in the left pane. 

 

Concept Walker - Displays the Concept Walker panel as a floating window (you also can click 

the toolbar’s Open New Walker icon). Use this window in addition to the Concept Walker 

panel, which you can display by clicking the Walker tab in the left pane.  

  

Concept/Term Details - Displays the Details popup window (you also can click the Open New 

Details Panel icon in the toolbar. The Concept/Term Details window lists detailed information 

for any concept, term, namespace, subset or association you drag and drop on the window from 

anywhere else in the application.  

 

Associations - Displays the Association Editor floating window, which allows you to create and 

maintain associations between concepts or terms within the same namespace, or across 

namespaces (you also can click the Open Association Editor icon in the toolbar). For each 

association you can specify one or more established qualifier types and values; these provide 

additional detail regarding the nature of a concept or term association (e.g., Usually). 

 

Properties - Displays the Property Editor floating window, which allows you to view, create, 

and maintain properties for a concept or term (you also can click the toolbar’s Open Property 

Editor icon). A property is a piece of user-defined information that can be linked to a concept or 

term, and can be used for any purpose. For each property you can specify one or more 

established qualifier types and values; these provide additional detail regarding the nature of a 

concept or term property (e.g., Current). 

 

Synonyms - Displays the Synonym Editor floating window, which allows you to establish a 

synonymous term for a concept (you also can click the Open Synonym Editor icon in the 

toolbar). 

 

Attribute Types – Displays the Attribute Types panel which combines the Association Types, 

Property Types, Qualifier Types, Kinds and Role Types editors, facilitating management of 

Types (metadata) for a specific Namespace.  

The Attribute Types panel provides a “top level” tab structure to accommodate the richer 

Metadata features available in DTS Version 4.X. The Namespaces tab includes all the 

Namespace-based types: Association Types, Property Types, Qualifier Types, Kinds and Role 

Types. Namespace Property Types now have Attaches To values of Namespace, Version, 

Concept, and Term. Namespace Qualifier Types have Modifies values of Concept Property, 

Concept Association, Term Property and Term Association. The new Subsets and Authorities 

tabs includes types supported by these objects: Property Types and Qualifier Types. These types 
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have Attaches To and Modifies values appropriate for their base object. Click this option to 

display the panel and manage attribute types. 

 

Namespace Editor - Displays the Namespace Editor floating window, which allows you to 

view, create, publish, and maintain the namespaces in your knowledgebase. The Namespace 

Editor panel supports creating, editing, deleting and viewing of Namespaces and related data, 

including Version information. It also supports exporting the columns in the upper table view to the 

clipboard or as a locally saved .csv file. To review the data associated with a specific namespace, 

select the namespace from the list. The lower panel will fill with the data on the namespace. This 

panel is identical to the Namespace tab in the Details panel and provides similar functionality. See 

the Detail panel description for more information. 

Specific to the Namespace Editor is the Publish option for local namespaces. This option is 

only enabled if the user has the ‘Manage’ NAMESPACE_MANAGE permission on the selected 

namespace. Publish finalizes the content in the Working version of the namespace and creates a new, 

named version. Pressing Publish opens the Publish Version dialog. Enter the name of the new 

version and click Publish to complete the operation. For a description of the Publish operation, see 

Publishing below. 

 

 
 

Namespace Profile Editor 

 

A Namespace Profile is a set of Namespace Attribute Types that are automatically added to a 

Namespace when the Namespace is created. The Namespace Profile Editor enables users to 

create, manage, and delete Namespace Profiles. Both User (specific to individual users) and 

System (accessible to all users) Profiles are available. The Namespace Profile Editor is available 

from this option, as well as from the New Namespace panel. See the Namespace Profile View 

and Maintenance section below for further information. 
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Subset Editor - Opens the DTS Editor Subset Editor panel as a floating window (you also can 

click the Open Subset Editor icon in the toolbar). The Subset Editor panel allows you to view, 

create, publish, and maintain the subsets in your knowledgebase. It also supports exporting the 

columns in the upper table view to the clipboard or as a locally saved .csv file. Refer to the Subsets 

discussion later in this guide for procedures on subset creation and maintenance. 
Specific to the Subset Editor is the Publish option for subsets. This option is only enabled if 

the user has the SUBSET_MANAGE permission on the selected subset. Publish finalizes the content 

in the Working version of the subset and creates a new, named version. Pressing Publish opens the 

Publish Version dialog. Enter the name of the new version and click Publish to complete the 

operation. For a description of the Publish operation, see Publishing below. 

 

 
 

Subset Profile Editor 

Similar to a Namespace Profile, A Subset Profile is a set of Subset Attribute Types that are 

automatically added to a Subset when the Subset is created. The Subset Profile Editor enables 

users to create, manage, and delete Subset Profiles. Both User (specific to individual users) and 

System (accessible to all users) Profiles are available. The Subset Profile Editor is available from 

this option, as well as from the New Subset panel. See the Subset Editor Panel section below for 

further information. 

 

 

Publishing - New Versions of both local Namespaces and Subsets can be created via the 

Publish feature of DTS 4.5. Publish is available via the associated button on the Namespace 

Editor and Subset Editor panels. After selecting, enter the name of the new Version and confirm 

the operation. When a Namespace is published, all data since the last published Version is 



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 19  

  

“finalized”, i.e., intermediate edits are removed and deleted Concepts and deleted Terms are 

changed to Inactive status. (The exception is Concepts and Terms added since the last Publish 

that are given a Deleted status will be completely removed, not inactivated.). Subset processing 

is similar. The new Version is then created and its Release Date set to the current time. Finally, 

the Published content is now considered Read-Only and a writable “Working” Version is created 

for further development. See the DTS Versioning Guide for more information on the publishing 

process. 

 

Authority Editor – Displays the Authority Editor panel which provides creation, editing and 

deletion capabilities for Namespace Authorities, similar to those provided by the Namespace 

Editor. The Authority Editor panel supports creation, editing and deletion capabilities for 

Authorities. It also supports exporting the columns in the upper table view to the clipboard or as a 

locally saved .csv file. To review the data associated with a specific authority, select the authority 

from the list. The lower panel will fill with the data on the authority. This panel is identical to the 

Authority tab in the Details panel and provides similar functionality. See the Detail panel 

description for more information 

 

Classify – Click this option to perform classification on an Extension local namespace (you also 

can click the Classify icon in the toolbar). Refer to the “Classify an Ontylog Extension 

Namespace” discussions in the DTS Classification Guide document for more on Ontylog and 

OntylogExtension namespace classification. 

 

Concept Compare - The Concept Compare panel is available to show the differences between 

two versions of a Concept, or differences between two concepts. Drag the desired Concept(s) 

into the Concept combo, and then select the comparison and base Versions as desired. See the 

DTS Versioning Guide for further information. 

 

Concept History – A new Concept History panel complements the Concept Compare panel and 

shows the history (across all Namespace Versions) of Concept Attributes for a selected Concept. 

See the DTS Versioning Guide for further information. 

 

Grid Editor – The Grid editor tool opens a panel which facilitates the viewing and updating of 

terminology content by providing convenient ways to select concepts, or terms, of interest in a 

batch grid process.  See the DTS Grid Editor Guide for further information 

 

Subset Compare - Opens the Subset Compare panel to compare the Concept membership 

between two Versions of the same Subset, or between Versions of two different Subsets. The 

new Subset Compare panel is available to compare the Concept membership between two 

Versions of the same Subset, or between Versions of two different Subsets. For additional 

information on the Subset Compare panel, see the DTS Versioning Guide.  

For more information on other Tools items like Subset Compare, Concept Compare, and 

Concept History, refer to the DTS Versioning Guide. 

 

 

 

http://www.apelondts.org/Downloads/Documentation
http://www.apelondts.org/Downloads/Documentation
http://www.apelondts.org/Downloads/Documentation
http://www.apelondts.org/Downloads/Documentation
http://www.apelondts.org/Downloads/Documentation
http://www.apelondts.org/Downloads/Documentation
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B.2.3 Options Menu  
Audit Report – The Audit Report option allows a user to define specifications to run reports to 

receive an audit history for DTS Editor activity for a given namespace.  The reporter can choose 

to include history for all or specific Users, all or specific Concepts, can choose to include related 

Terms and Attributes, and define a date range for which to gather the history.  Data can also be 

sorted either by User, or by Date.  Settings can be saved in order to rerun a report again in the 

future.  When a report is run, data is exported and saved locally as a .csv file. 

 

Set Clipboard Formats – Displays the Set Clipboard Formats panel. The DTS Editor supports 

system-wide keyboard copy (Ctrl-C) on displayed DTS objects to permit the transfer of 

information from DTS to other desktop applications. Multi-select copy is supported. The 

Clipboard Formats panel allow users to customize the strings created by the Editor in a copy 

operation. The Clipboard Module allows users to customize the strings created by the Editor in 

a copy operation. To use this option, select the Set Clipboard Formats option in the DTS Editor 

Options menu. 

 

Configuration Options – Displays the Configuration Options panel which shows information 

relating to the configuration of this instance of the DTS Editor. The Modules tab of this panel 

displays the names and versions of all installed DTS Editor Modules. All Modules can be shown 

or only the System or User Modules by selecting from the Filter dropdown. The Initializer tab 

allows users to associate user-written ConceptTermInitializers with namespaces. Initializers are 

invoked when a new Concept or Term is being created and allow complete initialization of the 

object, including specification of Code, Id, Synonyms, Properties, or Associations. The previous 

Code and Id Generator option has been replaced by a more general ConceptTermInitializer 

capability in the Configurations option. User-written ConceptTermInitializers are invoked when 

a new Concept or Term is being created and allow complete initialization of the object, including 

specification of Code, Id, Synonyms, Properties, or Associations. See Appendix A - Custom 

Initialization of Concepts and Terms for more information. 

 

Open Layout Editor – This item opens the Layout Editor panel. The Layout Editor supports the 

creation, editing and management of DTS Editor Layout specifications. See the DTS Editor 

Module Guide for a complete description of Layouts and use of the Layout Editor.  

 

Select Layout – Displays the Select Layout dialog: 

 

 
 

This dialog allows you to select and load a new DTS Editor Layout. Your User Layouts and all 

System Layouts are available in the dropdown. Select a Layout, press Apply and confirm your 

http://www.apelondts.org/Downloads/Documentation/tabid/137/Default.aspx
http://www.apelondts.org/Downloads/Documentation/tabid/137/Default.aspx
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selection in the resulting dialog. The new Layout will be loaded. It will not be necessary to 

reconnect to your server.  

 

Set Current Local Namespace – Lets you select the default local namespace, which determines 

the namespace used in dropdowns when adding and updating local content for a subscription 

namespace. You also can click the Set Current Local Namespace icon in the toolbar.  

   

Preferences – This displays the Preferences panel which provides three sub-items for managing 

DTS Editor Panel “preference” settings:  

 

AutoLocate Panel: Enable/disable the AutoLocate configuration item. Checking 

(enabling) this item results in the Editor remembering the screen location of floating 

panels and opening new instances of the same panel type at the previous location. 

AutoSize Panel: Enable/disable the AutoSize configuration item. Checking (enabling) 

this item results in the Editor remembering the screen size of floating panels and opening 

new instances of the same panel type at the previous size. 

Clear Preferences: Selecting this item opens a confirmation dialog for clearing all the 

panel Preferences. If accepted, all saved panel locations and sizes will be reset to their 

defaults, generally centered in the Editor at their preferred sizes. 

 

Module Manager - This option opens the Module Manager panel that enables the loading, 

updating, and removal of DTS Editor User Modules without direct user intervention. Module 

information is uploaded from an Internet accessible file. Module version information is available 

and Module actions (Add, Update, Remove) can be specified. These actions are performed on 

the next DTS Editor restart. For detailed information on Module Manager operation, see the 

Using the Module Manager section later in this document.  

 

PUB/SUB Notifications – This option opens the Configure DTS Notifiers panel of the DTS 

Publish/Subscribe system. The Publish/Subscribe system supports notification of DTS server 

events, such as namespace creation and namespace version publishing, to client listeners 

(subscribers). Event notifications in the form of XML messages are sent to registered subscriber 

URLs. The Configure DTS Notifiers panel allows entry of listener URLs and specification of 

notification parameters. The PUB/SUB Notifications option is only enabled for users having the 

apelondtsadmin Application Server role. For more information, see the Publish Subscribe 

Introduction Guide. 

 

User Manager - This module manages Roles and User Profiles. The User Manager enables the 

creation of DTS Roles and their association with Permissions, and the creation of DTS User 

Profiles and assignment of the Roles to these Users. The User Manager option is only enabled 

for users having the apelondtsadmin Application Server role. For more information, see the User 

Manager Guide. 

B.2.4 Help  
Help Topics - Provides online help (you also can click the Help icon in the toolbar). To simplify 

DTS documentation update and release processes, current documentation is hosted online at 

http://www.apelondts.org/Downloads/Documentation
http://www.apelondts.org/Downloads/Documentation
http://www.apelondts.org/Downloads/Documentation/tabid/137/Default.aspx
http://www.apelondts.org/Downloads/Documentation/tabid/137/Default.aspx
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www.ApelonDTS.org. 

 

About DTS Editor – Shows the DTS Editor version, copyright date, etc., for the DTS Editor 

instance. Additional technical information on the client and server configurations is available by 

clicking on the Details >> label in the popup: 

 

 
 

B.3 DTS Editor Main Window Toolbar Options 
Most of the options available from the menus on the DTS Editor Main window also are available 

from the window toolbar.  

 

 
 

 Connect to DTS Server - Establishes your connection to the DTS Server and the 

knowledgebase (you also can click Connect in the File menu). 

 

 Disconnect - Disconnects you from the DTS Server and the knowledgebase  

(you also can click Disconnect in the File menu). 

 

 Open New Tree - Displays the Concept Tree panel as a floating window (you  

also can click New Concept Tree in the Tools menu). Use this window in conjunction with the 

Concept Tree panel that you can display by clicking the Tree tab in the left pane.  

with the Concept Walker panel that you can display by clicking the Walker tab in the left pane.  

 

 Search – Displays the Search panel as a separate window (you also can click  

New Search in the Tools menu). The Search panel allows you to search for a concept based on 
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the parameters you specify. Use this window in conjunction with, or as an alternative to, the 

Search panel that you can display by clicking the Search tab in the left pane. 

 

 Open New Walker - Displays the Concept Walker panel as a floating window  

(you also can click New Concept Walker in the Tools menu). Use this window in conjunction 

 

 Set Current Local Namespace - Allows you to select the default local  

namespace, to which you can add and maintain local content for a subscription namespace (you 

also can click Set Current Local Namespace in the Options menu).  

 

 Classify - Click to open the Ontylog Classification panel (you also can click Classify in the 

Tools menu). Refer to the Classify an Ontylog Extension Namespace discussions in the Ontylog 

Extension Namespaces and Extension Namespace Classification in DTS document for more on 

Ontylog Extension namespace classification. 

 

 Open New Details Panel - Displays the Details panel as a floating  

window, which lists detailed information for any concept you drag and drop on the window from 

anywhere else in the application (you also can click Concept/Term Details in the Tools menu).  

 

 Open Association Editor - Displays the Association Editor as a floating window,  

which allows you to create and maintain associations between concepts or terms within the same 

namespace, or across namespaces (you also can click Associations in the Tools menu).  

 

 Open Property Editor - Displays the Property Editor as a floating window, which  

allows you to view, create, and maintain properties for selected concepts (you  

also can click Properties in the Tools menu).   

 Open Synonym Editor - Displays the Synonym Editor as a floating window,  

which allows you to establish a synonymous term for a concept (you also can click Synonyms in 

the Tools menu).  

 

 Open Subset Editor - Displays the Subset Editor as a floating window (you also can click 

New Subset Editor in the Tools menu). The Subset Editor panel allows you to view, create, 

publish, and maintain the subsets in your knowledgebase. Refer to the Subsets discussion later in 

this guide for procedures on subset creation and maintenance. 

 

 Help - Provides online help (you also can click Help Topics in the Help menu). To 
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simplify DTS documentation update and release processes, current documentation is hosted 

online at www.ApelonDTS.org. 

 

B.4 DTS Editor Main Window Tab View Options  
The following tabs are displayed in the left DTS Editor panel (under the icon bar described 

above) when the DTS Editor Main window opens initially. Each brief introduction that follows 

outlines the view panel displayed when you click the appropriate tab. Detailed procedures and 

discussions on use of these panels are provided later in the guide. 

Tree - The Concept Tree view panel displays as the default in the left pane when the main 

window first opens. When either of the other panels (Search or Concept Walker) displays in the 

left pane, click the Tree tab to redisplay the concept tree. This tree unfolds the taxonomy to 

display the concept hierarchy in a selected namespace in the knowledgebase, or an association 

tree.  

Walker - Displays the Concept Walker panel, which lists the parents and children of a concept in 

the selected namespace. 

Search - Displays the Search panel, which allows you to search for concepts based on the 

parameters you specify (Name, Property, Role, etc.). 

B.4.1 DTS Editor Keyboard Options 
Press the Enter key to perform the default action (e.g., Apply, Close, OK, etc.) in any panel or 

popup window. Press the Esc key to close any displayed popup window. 

B.4.2 View Concept Tree – Tree Panel aka Tree Tab 
The DTS Editor Concept Tree panel lists concepts in a “tree” format for easy viewing. As 

mentioned earlier, the Concept Tree panel displays in the left pane when the DTS Editor Main 

window first opens, or when you click the Tree tab. Top-level namespaces/concepts (“nodes”) in 

the hierarchy display in a collapsed view. You can expand or collapse segments of the tree to 

display only those elements you want. 

 

http://www.apelondts.org/
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B.5 Concept Tree Panel Display Preferences 
Right click in a white-space area of the Concept Tree panel to view the Concept Tree display 

preference settings. 

B.5.1 Click to Edit (Ontylog or Thesaurus Tree) 
The Click to Edit option (on by default) is available for either an Ontylog or a Thesaurus tree. If 

you click Click to Edit, any concept you select displays automatically in the  Details panel. If 

you unselect this option, you will need to drag the selected concept to the Details panel for view. 

 

  

B.5.2 Set Tree Config… 
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The Set Tree Config… panel allows you to configure the Display Name and Sort parameters for 

each namespace in your knowledgebase.  

 

 
 

Namespace - From the Namespace field you can select the Namespace that you would like to 

customize. 

 

Display Name - You can change the Display Name to another attribute, Concept Name, 

Preferred Term, a specified Synonym, or a specified Property. The default is set to the Concept 

Name. 
 

Sort Name - You can change the Sort Name to Concept Name or a specified Property. The Sort 

Order can be set from Low to High or High to Low and Alpha Order or Numeric Order.  

Any changes you make to the Concept Tree panel display settings are retained if you disconnect 

from the current session (File>Disconnect) or exit the DTS Editor (File>Exit).  
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B.5.3 Reload Tree 
The Reload option allows you to manually refresh the Tree when data has been externally 

modified.  

B.5.4 Icons and Colors 
The following icons indicate concept or term attributes in the DTS Editor. These icons and colors 

are defined in advance for you (you cannot modify them).   

 
Symbol/ color   Description 

 Indicates a concept object (used in multiple panels). 

 
Indicates a term object (used in multiple panels). 

 
Indicates a concept in the Concept Tree panel. In the Concept/Term Details panel, 

indicates a subconcept of the concept displayed in the detailed view. 

 
In the Concept/Term Details panel, indicates a Superconcept of the concept 

displayed in the detailed view. 

 
In the Concept Tree and Concept/Term Details panels, indicates a synonym for a 

concept. 

 
In the Concept Tree and Concept/Term Details panels, indicates a property (such 

as print name, medical code, etc.) for a concept. 

 
In the Concept Tree and Concept/Term Details panels, indicates the role that 

relates one concept to another. 

 
In the Concept Tree panel, indicates the non-editable values concept Code, 

concept ID, and Namespace. 

 
In the Concept Tree and Concept/Term Details panels, indicates an association 

between one concept and another. 

 
In the Concept Tree and Concept/Term Details panels, indicates an association or 

property qualifier for a concept. 

 
In the Concept Tree panel, indicates that the concept in the detailed view is 

included in the subset that is listed.  

 
In the Subset Editor and Subset tab of the Details panel, indicates the Subset 

Description. In the Concept and Term tabs of the Details panel, indicates that the 

object Status is modifiable. 

 
In the Namespace Editor, Subset Editor and Namespace and Subset tabs of the 

Details panel, indicates a Version of the associated DTS object. 

 
In the Subset Editor and Subset tab of the Details panel, indicates the Subset 

Expression. 

 
Indicates that the Read-Only/Read-Write attribute of Namespaces and Subsets is 

modifiable (used in multiple panels).  

 
Indicates that the Authority attribute of Namespaces and Subsets is modifiable 

(used in multiple panels). 



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 28  

  

B.5.5 Concept Name and Attribute Text Wrapping 
If lengthy concept names and/or attribute text extend beyond the border of the Concept Tree 

panel, the text will wrap around to a new line. The concept name or attribute text also will be 

enclosed in brackets. 

 

 
 

If you enlarge the Concept Tree panel, the panel size setting is retained if you disconnect from 

the DTS Server, then reconnect. During the next session, the text wrapping and brackets will be 

removed if they are not required in the larger panel. 

 

B.6 Multiple Panel Instances 
The DTS Editor allows you to open multiple occurrences of the Concept Tree, Concept Walker, 

and Search panels by selecting these options from the Tools menu, by clicking the appropriate 

tab, or by clicking the corresponding icon in the toolbar. Each instance of the panel displays as a 

free-floating, sizable window; the size and location of these floating panels are retained for 

future sessions.  

 

You can view, compare, and drag information from multiple instances of each window. The data 

in each instance of the window can be from the same namespace, or can reflect data from 

different namespaces. Drag and drop capability between the DTS Editor windows and panels lets 
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you create associations between namespaces, and view the results immediately on the Concept 

Tree panel. 

 

In the following illustration, two floating instances of the Concept Tree panel window (each 

showing a different namespace) have been opened and placed over the left side of the DTS main 

window.  

 

 
 

In the next illustration, the main Concept Tree panel displays in the left pane, and an additional 

floating Concept Tree panel has been placed in the bottom right of the DTS main window.  
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B.7 Customize the Tree View 
The Tree panel initially displays trees for all namespaces. Follow these procedures to select a 

specific namespace for which you want to view data. The format of the concept tree display 

depends in part on the type of namespace you select, Ontylog or Thesaurus. Based on the view 

parameters, you configure the tree to display in either a hierarchical format 

(subconcepts/superconcepts) or an association format that reflects concepts associated with a 

specific focus concept. You can expand and collapse the tree in either format, as needed. 

Formats that display subset participation are also available. 

B.7.1 Hierarchy Tree View 

Select the namespace for which the concept tree will display from the Namespace dropdown 

field list. Click the dropdown arrow to display all namespaces available for view options. 
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Select the namespace version for which the concept tree will display from the Version field 

dropdown field list. The default is the most recent version. For more information on the Version 

selection widget, see the Versioning Guide. 

 

 
 

When you select an Ontylog namespace for view, the default in the View Axis dropdown field is 

Superconcepts/Subconcepts, which results in a hierarchal view of the namespace concepts. 

 

 
 

http://www.apelondts.org/Downloads/Documentation/tabid/137/Default.aspx
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You may also select Defined Hierarchy which will display concepts instead of the Super/Sub 

hierarchy, but by their definition hierarchy. 

 

 
 

To expand a selection to view lower-level nodes, click adjacent the Expand button  . When 

expanded, the concepts are listed in a hierarchical scheme, or “taxonomy.”  

 

 
 

If there is no Expand button adjacent to a concept, it indicates there are no additional 

subconcepts hidden for the concept. The nodes immediately above a concept are called direct 

superconcepts (parents). Nodes immediately below a concept are called direct subconcepts 

(children).  

 

As you expand the tree, you may want to collapse the tree to view only the higher levels of the 

hierarchy. Click the collapse button  to hide the subconcepts. 
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B.7.2 Association Tree View 
Select the namespace for which the concept tree will display from the Namespace dropdown 

field list. Click the dropdown arrow to display all namespaces available for view options. 

When you select an Ontylog namespace for view, the default in the View Axis dropdown field is 

Superconcepts/Subconcepts, which results in a hierarchal view of the namespace concepts. If 

you wish, you can configure a tree view that consists of all concepts for which associations are 

established for a specified concept. An association is a relationship between concepts and/or 

terms within a namespace, or across namespaces. 

 

The default association type for an association tree configuration is Parent Of.  

 

 
 

The association tree that displays in the Concept Tree panel reflects the default association type. 
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You have the option of selecting another association type on which to base the tree view. Click 

the arrow on the View Axis field to list all existing concept associations in the knowledgebase. 

Click the desired association to select it; the namespace in which the association was created 

displays in parentheses. 

You also have the option of establishing a focus concept in your association tree. The focus 

concept serves as the root concept in your tree view. 

  

Drag a concept from another panel or window (e.g., Concept /Term Details panel) and drop it 

into the Focus Concept field. The focus concept sets the starting point (i.e., root, or threshold) for 

the chain of associations to be displayed. 

 

 
 

To view concepts with associations to those listed in the displayed association tree, click the 

Expand button  next to the desired concept in the tree. Note the illustration.  
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B.7.3 View Concepts in a Selected Namespace Subset 
A subset is a set of concepts that you can create from namespaces and other subsets, based on 

selection criteria that you define.  

 

The concepts in each subset can share associated attributes, and each subset may include a few 

concepts or many concepts. Refer to the Subsets discussion later in this guide for procedures on 

subset creation and maintenance. 

 

If the namespace in the view has one or more subsets created for it, you can choose to highlight 

each concept in the Tree view that was selected for a subset. The Subset field dropdown lists all 

existing subsets for (only) the namespace in the view; the subsets display in gold color. 
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Click the desired subset in the list. Each namespace concept that is included in that subset is 

highlighted (in gold color) in the hierarchy tree in the Concept Tree panel. 
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You also can view the concept hierarchy within each subset. From the View Axis field dropdown 

list, select Subset Hierarchy (Subset Hierarchy is enabled as a selection only when a 

namespace that has existing subsets is in the view). From the Subset field dropdown list, select 

the subset for which you want to view a concept hierarchy. 

 

The hierarchy tree for the subset (only) displays, also in gold color.  

 
 

Click the Expand  and collapse  buttons to view and hide subconcepts, as needed. 
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B.8 Concept Walker View 
The Concept Walker provides a view of a selected concept’s place in the Concept Tree, and its 

relationships with other concepts. You can configure the view to reflect either a 

Subconcept/Superconcept hierarchical, Defined Concepts hierarchical, or an association format 

that reflects concepts associated with a specific focus concept. Formats that display subset 

participation are also available. 

B.8.1 Hierarchy View 
Follow this procedure to display and use the Concept Walker panel to provide a view of the 

selected concept’s relationships (i.e., ancestor and descendant concepts).  

 

1. Click the Walker tab in the upper-left portion of the DTS Editor Main window. The 

Concept Walker panel displays in the left pane. 
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The dropdown field in the center of the panel (Focus Concept) is where you select the 

concept for which relationships will be listed. If you used the Concept Walker earlier in 

the current session, previous focus concepts are retained in the Focus Concept field pull-

down list for your selection.   

2. You can drag any concept visible on another window or panel (Search panel, 

Concept/Term Details panel, etc.) to the Focus Concept field on the Concept Walker 

panel. For example, click the Search tab to display the Search panel, or click the Search 

icon in the toolbar to display the floating Search window; you can position the floating 

window so that it is adjacent to the Concept Walker panel. 

 

Drag a concept to the Focus Concept field and release the mouse to drop the concept.  

3. When you select a focus concept from an Ontylog namespace for view, the default in the 

View Axis dropdown field is Superconcepts/Subconcepts, which results in a hierarchal 

view of the namespace concepts. You also have the option of the Defined Concept 

hierarchy for Subscription Ontylog Namespaces. 

4. If the focus concept you selected is from an Ontylog namespace, the name of that 

Ontylog namespace displays in the Namespace field.  If any Ontylog Extension 

namespaces exist for that namespace, these will be listed in the Namespace field 

dropdown list.  

 

An Ontylog Extension namespace is an extension of a specifically linked Ontylog 

Subscription namespace. You create an Ontylog Extension namespace to create and 

maintain new local content for the linked Ontylog subscription namespace. From the list, 

select the Ontylog Extension namespace for which you want to display a hierarchy view. 

Refer to the Concept Walker View and Ontylog Extension Namespaces discussions in the 

Ontylog Extension Namespaces and Extension Namespace Classification in DTS 

document for more on using the Concept Walker with Ontylog Extension namespaces. 

5. If your Focus Concept has one or more parents, these display in the Parent section above 

the Focus Concept dropdown field. The section below the Focus Concept dropdown field 

displays the subconcepts, or children, of the concept. 

6. In the Parents section, you can expand any visible ancestor concept to list its parent 

concepts. Click the Expand button . Higher-level concepts are listed in inverse order to 

their place in the hierarchy tree.  
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7. In the Subconcepts section, click the Expand button  to expand the hierarchy and list 

children for any visible descendant of the concept you selected. The focus concept is the 

root for this part of the view. 

 

B.8.2 Association View 
You can configure a Concept Walker view that consists of all concepts for which associations 

are established for a specified concept. Each association is a relationship between concepts 

and/or terms within a namespace, or across namespaces. 

Follow this procedure to display and use the Concept Walker panel to provide a view of 

associations for the selected concept. 

 

1. Click the Walker tab in the upper-left portion of the DTS Editor Main window. The 

Concept Walker panel displays in the left pane. 

 

The dropdown field in the center of the panel (Focus Concept) is where you select the 

concept for which relationships will be listed. If you used the Concept Walker earlier in 

the current session, previous focus concepts are retained in the Focus Concept field pull-

down list for your selection.  

2. You can drag any concept visible on another window or panel (Search panel, 

Concept/Term Details panel, etc.) to the Focus Concept field on the Concept Walker 

panel. For example, click the Search tab to display the Search panel, or click the Search 

icon in the toolbar to display the floating Search window; you can position the floating 

window so that it is adjacent to the Concept Walker panel. 
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3. Drag a concept to the Focus Concept field. When the field changes to yellow, unclick the 

mouse to drop the concept. The focus concept will serve as the root concept in your 

association view. 

4. When you select a focus concept from an Ontylog namespace for view, the default in the 

View Axis dropdown field is Superconcepts/Subconcepts, which results in a hierarchal 

view of namespace concepts. Click the arrow on the View Axis field to list all existing 

concept associations within all the namespaces in your knowledgebase.  

 

 

 

Click the desired association to select it (the namespace in which the association was 

created displays in parentheses). The concept(s) for which there are associations with the 

Focus Concept are listed in the Concept Walker panel. In the following illustration for the 

focus concept Allergy (LP31625-4), the concepts associated through the association 

Multiaxial Parent Of are listed. 
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You can drag the returned concept to the Concept/Term Details panel to view attribute 

details. 

B.8.3 View Subset Concepts in the Concept Walker 
If the Focus Concept field concept is from a subscription, local, or (classified) extension 

namespace for which a subset exists, you can choose to highlight in the displayed hierarchy those 

concepts within that subset. From the Subset field dropdown (which lists all subsets for the 

Focus Concept namespace field, in gold text) select the desired subset.  

 

The Namespace field reflects the namespace from which the subset concepts were derived. Each 

concept from the focus concept Namespace that is listed in the Parents and Subconcepts 

hierarchies is highlighted (in gold color). 
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If the focus concept is from an Ontylog namespace, you also can view a select portion of the 

concept hierarchy for each of the Ontylog namespace’s subsets. From the View Axis field 

dropdown list, select Subset Hierarchy (Subset Hierarchy is enabled as a selection only when 

the concept in the Focus Concept field is from a subset namespace).  

 

From the Subset field dropdown list, select the subset for which you want to view a portion of 

the concept hierarchy. 

 

The hierarchy tree for the subset (only) displays, also in gold color. 
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Click the Expand  and collapse  buttons to view and hide subconcepts, as needed. 

 

B.9 Concept Walker Panel Display Preferences 
Right click in a white-space area of the Concept Walker panel to view the Concept Walker 

display preference settings. The Concept Walker supports the Click to Edit and Set Tree Config 

… options as previously described in the Concept Tree display preferences. Note that the values 

for these preference options are shared with those in the Concept Tree panel, i.e., setting Click to 

Edit on the Concept Walker panel also sets Click to Edit in the Concept Tree panel. 

The Parents (upper) section of the Concept Walker panel also supports a Top Down 

Tree/Bottom Up Tree display preference. In the examples above, the Parents section has 

shown hierarchies displayed in the Bottom Up view, i.e., the concept trees grow “up” from the 

bottom of the section. To have the trees grow “down” from the top of the section (as was the case 

prior to DTS 4.0) select Top Down Tree from the preference menu. You can restore the current 

default behavior by selecting Bottom Up Tree. 

B.10 Dynamic Click to Edit 
The Dynamic Click to Edit functionality extends upon the Click to Edit functionality in that it 

allows customization of Concept/Term transfer support. Dynamic Click to Edit allows 

specification of which panels to use as sources and targets when a Concept/Term is clicked. This 
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can be especially useful when using floating panels where Click to Edit functionality is not 

available by default. The three panel types include: 

 

 Source Panels – These panels act as sources for Click to Edit operations. The Search 

Panel is a Source Panel.  

 

 Target Panels – These panels act as receivers for Click to Edit operations. The Details 

Panel is a Target Panel.  

 

 Combination Panels – These panels act as both sources and targets for Click to Edit 

operations. The Tree and Walker Panels are Combination Panels. 

 

To view the current Dynamic Click to Edit assignments for a panel, hover over the icon. The 

example below indicates that clicking on a search result will transfer that concept/term to the 

Details Panel.  

 

 
 

To set Dynamic Click to Edit assignments for a panel, open both panels that you want to use. 

Note that no Target Panel is currently set for this floating Search Panel.  

 

 
 

Set the Target Panel by dragging the arrow of the Target Panel to the arrow of the Source Panel. 

Dragging the floating Details Panel arrow to the floating Search Panel arrow defines the Details 

Panel as the target for the Search Panel. The panels are now configured so that clicking on a 

Search result will transfer the concept/term to the Details Panel.   
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To remove a Dynamic Click to Edit assignment, click on the arrow of the Source Panel and 

select ‘Clear transfer target’. You can also turn off Click to Edit, but this will affect all panels, 

not just those configured for Dynamic Click to Edit.  

 

 

C. Concept Search 
Use the DTS Editor Search tab panel to search a selected namespace, or all namespaces, and 

retrieve specific concepts, concept terms, or concepts and synonyms that match the search 

criteria you specify. Search can be performed on any attribute defined in the DTS 

knowledgebase. You then can drag and drop any retrieved concept/term into another view panel 

(e.g., Concept/Term Details) for further review, or onto one of the Editor windows (e.g., 

Synonym Editor, Property Editor). You can display the Search panel as a floating window; this 

option is available from the toolbar on the DTS Editor Main window menu bar, as well as from 

the Tools menu (Tools>Search).  

Search a selected namespace, all namespaces, or a selected namespace subset based on any of the 

following criteria: 

• Name 

• Name & Synonyms 

• Synonym  

• Concept Property 

• Concept Property Qualifier 

• Role 

• Inverse Role 



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 47  

  

• Concept Association 

• Inverse Concept Association 

• Concept Association Qualifier 

• Id 

• Code 

• Kind (specific namespace only, not “all”) 

To display the Search panel, click the Search tab on the DTS Editor Main window. 
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Follow this procedure to search the namespace based on the criteria you specify. 

1. Assure that the Search tab is selected and the search criteria fields display. 

2. To search for matching concepts, click Concepts. To search for matching terms, click 

Terms. 

3. Select the types of Concepts to be searched from the Status dropdown. When searching 

for Concepts with Status A11, individual search results are prefixed with an icon if 

Inactive or Deleted.  

4. From the Page Size field dropdown list, select the number of concepts and/or terms to be 

retrieved from each search. From the dropdown, you can specify that the page size search 

limit be 10, 50, or 100. 10 is the default. Another page size can also be explicitly entered, 

with a maximum value of 999. Retrieved concepts or terms display in the Search Results 

area in the lower portion of the tab.  

 

The Search panel also supports retrieving a specific page number for result sets larger 

than one page.  Entering “4”, for example, will return the 4th page of search results, 

preventing the user from having to page over numerous times to find the desired result.  

If no page is entered, the Search function will return the first page of results by default.  If 

a number larger than the number of pages in the result set is entered, the Search function 

will return the last page of results. 

5. The Show Count Only checkbox is an optional feature that will display the total number 

of search results that meet the specified criteria without actually displaying the results in 

the Search Results area in the lower portion of the tab. 

6. In the Search For field, specify the value (i.e., search string) for which you want to 

search the namespace for a match. Specify the search string value in one of these 

manners: 

• Enter the specific search string in its entirety (e.g., abdomen endoscopy). 

• Broaden the search criteria by entering the asterisk (*) wildcard character. Note 

these examples when Name is the Search By parameter: 

o To retrieve all concept/term names containing the string abdomen, type 

*abdomen* as the search string in the Search For field. 

o To retrieve only concept/term names that begin with the string abdomen, 

type abdomen* as the search string in the Search For field. 

o To retrieve concept/term names that end with the string abdomen, type  

*abdomen as the search string in the Search For field. 

7. In the Search In area of the panel, click the option that reflects where you want to 

perform the search (Namespace or Subset). If you select Namespace, the accompanying 

dropdown lists all namespaces in your DTS knowledgebase.  

 

Click the namespace in which you want to perform the search. The default, All, applies if 

you want to search in all existing namespaces. Note that if you select an Ontylog 
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Extension namespace to search, the results will be from the Extension namespace only 

(no concepts from the linked Ontylog subscription namespace will be returned). Refer to 

the Ontylog Extension Namespaces and Extension Namespace Classification in DTS 

document for more on Extension namespaces. 

 

If you select a Subset in which to search, the accompanying dropdown lists all subsets 

that were created for namespaces in your DTS knowledgebase.  

 

Click the subset in which you want to perform the search.   

The version dropdown lists all versions that are available for the specified namespaces or 

subsets in your DTS knowledgebase. Select the version in which you want the search 

performed. The latest (most recent) version is the default. 

 

8. In the Search By field, select the parameter that will be searched in the namespace(s) or 

subset for the string you specified in the Search For field.  

 

For concept searches the following options are available: 

• Name - This search will retrieve each concept (or each term, if you are 

performing a term search) with a name that matches the search string parameter 

you specified in the Search For field. 

• Name & Synonyms - This search will retrieve each concept with a name that 

matches the search string parameter you specified and each concept with a 

synonym that matches the search string parameter you specified in the Search For 

field. Name & Synonym search is not available for Terms. 

• Synonym - This search will retrieve each concept with a synonym that matches 

the search string parameter you specified in the Search For field. 

• Concept Property - This search will retrieve each concept with a property value 

that matches the search string parameter you specified in the Search For field, for 

the property or properties you select. If you select Property as the search 

parameter, a list of current knowledgebase properties displays in the Search On 

list area; you select the properties to be searched from this list. 

• Concept Property Qualifier - This search will retrieve each concept with a 

concept property qualifier value that matches the search string parameter you 

specified in the Search For field, for the property qualifier you select. If you 

select Concept Property Qualifier as the search parameter, a list of current 

knowledgebase properties displays in the Search On list area; you select the 

concept property qualifier to be searched from this list. 

• Role - This search will retrieve each concept with a role value (i.e., target concept 

name) that matches the search string parameter you specified in the Search For 

field, for the role type(s) you select (e.g., Procedure site). If you select Role as 
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the search parameter, a list of current role types displays in the Search On list 

area; you select the role type(s) to be searched from this list. 

• Inverse Role - This search will retrieve each concept with an inverse role value 

that matches the search string parameter you specified in the Search For field, for 

the inverse role type(s) you select (e.g., Procedure site). If you select Inverse 

Role as the search parameter, a list of current inverse role type(s) displays in the 

Search On list area; you select the inverse roles to be searched from this list. 

• Concept Association - This search will retrieve each concept that has an 

association target concept with a name that matches the search string parameter 

you specified in the Search For field, for the association(s) you select (e.g., Is A 

Parent Of). If you select Concept Association as the search parameter, a list of 

current association type(s) displays in the Search On list area; you select the 

association type(s) to be searched from this list. 

• Inverse Concept Association - This search will retrieve each concept that has an 

inverse association from concept with a name that matches the search string 

parameter you specified in the Search For field, for the inverse association(s) you 

select (e.g., Is A Parent Of). If you select Inverse Concept Association as the 

search parameter, a list of current inverse association types displays in the Search 

On list area; you select inverse association type(s) to be searched from this list. 

• Concept Association Qualifier - This search will retrieve each concept that has 

an association qualifier with a name that matches the search string parameter you 

specified in the Search For field, for the association(s) you select. If you select  

• Concept Association Qualifier as the search parameter, a list of current 

association qualifier type(s) displays in the Search On list area; you select the 

association qualifier type(s) to be searched from this list. 

• Id – This search will retrieve each concept (or term, if you are in a term search) 

that has an ID that matches the search string parameter you specified in the 

Search For field. 

• Code – This search will retrieve each concept (or term, if you are in a term 

search) that has a Code that matches the search string parameter you specified in 

the Search For field. 

• Kind – This search will retrieve each concept, with a specified namespace, that 

has a Kind value that matches the search string parameter you specified in the 

Search For field.  Note, this search requires that a namespace be selected in the 

search tool, and cannot be run against an “all namespaces” search. 

9. After you specify all search criteria, click Search. The retrieved concepts and/or terms 

are listed in the Search Results area in the lower portion of the tab. When you find the 

desired concept(s), you can drag the concept(s) to the Concept Walker or Concept/Term 

Details panel to view details.  
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Note that after you click Search to begin the search, the button changes to Cancel; to 

terminate a long-running search, click Cancel and enter alternate search criteria. The 

button changes back to Search when the search is completed.  

 

The primary search parameters (Search On, Status, Page Size, Show Count Only, Search 

In, and Namespace) are saved in the Editor configuration so that the most recently used 

parameters are automatically populated upon starting DTS or opening a new Search 

panel.  

When searching on attributes other than just Name, ToolTips are available on each result line to 

show where the match string was found. In the screen shot below, the “*heart*” search term has 

been located in the Name and two of the Synonyms in the Abdominal heart (disorder) concept. 

 

To increase performance of Search, the use of ToolTips can be disabled. To disable ToolTips, 

right-click anywhere in the Search Results area in the lower portion of the tab and select Show 

Search ToolTips. When this option is disabled, hovering over results will not display the ToolTip 

indicating where the match string was found, but performance of search will improve.  

 

If more than Page Size results are found that match the search criteria, the result count (found on 

the right immediately above the result list) will display in red and the “next page” icon ( ) will 

be enabled. Use this icon, and its partner, the previous page icon ( ), to move among the result 

pages. 
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D. Namespace Maintenance 

D.1 Overview 
Each namespace in DTS represents an individual source terminology (e.g., SNOMED, ICD-9-

CM) or independently developed terminology content, e.g., a local namespace containing map 

(association) information. The DTS Editor provides a set of options that allow you to view data 

in all namespaces, edit namespaces of certain types, and create new, local namespaces. 

   

A namespace authority indicates the organization (e.g., U.S. National Library of Medicine, U.S. 

Medical Terms Review) that approved and/or certified a specific terminology. A namespace 

authority must be specified as part of each namespace definition. In addition to namespace 

maintenance, authority maintenance is discussed in this section. 

 

A namespace’s locality indicates how the namespace data was acquired. A Subscription 

namespace is one for which content was loaded into DTS through a subscription import. A Local 

namespace is one that was created using the DTS Editor, from DTS import utilities, or from user 

programs using the DTS API, for the purpose of using and maintaining local terminology 

content.   

 

In DTS, a namespace is one of four distinct types: Subscription Ontylog, Local Ontylog, 

Thesaurus, or Ontylog Extension. Each namespace type is described briefly, as well as the 

level of functionality available in each namespace type using the DTS Editor. 

D.1.1 Subscription Ontylog Namespaces 
Ontylog is a language used to build and maintain large knowledgebases using description logic. 

Concepts in Ontylog are organized into a taxonomy by a process called classification. A 

Subscription Ontylog namespace is one provided by Apelon’s Subscription Content Distribution 

process, and is by definition “read-only”.  

 

The DTS Editor provides view capabilities for Subscription Ontylog subscription namespaces. In 

the DTS Editor you can view the concept hierarchy tree in any selected Subscription Ontylog 

terminology namespace. You also can view attribute details (e.g., properties, roles) for any 

selected concept in the namespace. 

 

You cannot use the DTS Editor to perform edits directly to a Subscription Ontylog-type 

namespace. However, the DTS Editor allows you to create and maintain new content for the 

Subscription Ontylog namespace through two different approaches. 

• You can create a new local, editable namespace using the DTS Editor 

o Within this local namespace you can add new properties, synonyms and 

associations (including qualifiers to properties and associations) to the 

Subscription Ontylog concepts.  
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o Because the local content is in a separate namespace, this approach prevents 

inadvertent overwrite of this local data if the Subscription Ontylog namespace is 

updated at a later time.  

• You can create a local, editable Ontylog-Extension namespace using the DTS Editor to 

integrate new concepts and terms (and their relationships) with the Subscription Ontylog 

namespace. See Ontylog Extension Namespaces below for more information. 

D.1.2 Local Ontylog Namespaces 
A Local Ontylog Namespace is one created within the DTS Editor, utilizing the Local Ontylog 

Namespace options newly added to DTS 4.5.  With these tools you can now create your own 

local namespaces with the same Ontylog description logic.  Local Ontylog Namespaces also 

undergo the same process of classification to be organized into a taxonomy.  Once created, 

Local Ontylog Namespaces, unlike Subscription Ontylog Namespaces, can remain read-write 

until published and edits are finalized. 

D.1.3 Ontylog Extension Namespaces 
You can create an Ontylog Extension namespace:  

• As its title implies, each Ontylog Extension namespace is an extension of a specific 

Subscription Ontylog namespace, created for the purpose of creating/maintaining new 

local content for the linked Subscription Ontylog namespace. 

• In the Extension namespace you can add new concepts, add or change concept 

relationships (i.e., superconcept/subconcept relationships) add or change role relationship 

values, and add new associations for the Subscription Ontylog namespace. 

• You can classify the Extension namespace against the linked Subscription Ontylog 

namespace, then view the new hierarchy for the Ontylog Extension namespace; the 

displayed Extension namespace hierarchy reflects both the linked Subscription Ontylog 

namespace concepts, and concepts from the Extension namespace.  

D.1.4 Thesaurus Namespaces 
A Thesaurus namespace is one that is created from locally defined information, e.g., concepts, 

terms and associated attributes. Data in a thesaurus namespace can reference (via local 

associations) information in any namespace including an Ontylog namespace. For Thesaurus 

namespaces, concepts are organized based on relationships (associations) with other concepts. 

Subscription namespaces with the type of Thesaurus are not editable in the DTS Editor. 

However, you can create a new local namespace that is a Thesaurus type and create and 

maintain content locally.  

 

D.2 Current Local Namespace 
Since a DTS knowledgebase often contains many local namespaces, each having multiple 

attribute types, selection of the desired type during the editing process can be awkward. The DTS 

Editor defines a Current Local Namespace for the purpose of shortening the content in 

dropdowns, etc. used in the editing process. Select Set Current Local Namespace from the 

Options menu to set a current local namespace using the Set Current Local Namespace window. 

The namespace you specify here becomes the default local (writable) namespace for the addition 
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and maintenance of the property types, association types, and qualifier types used during the 

addition of local content. 

 

 

 
 

1. Thereafter, you can add a new property, synonym, or association to a concept or term in a 

namespace, by selecting the appropriate attribute type (e.g., property type) from the 

Current Local Namespace. Remember that the Current Local Namespace is simply a 

convenience to reduce the complexity (length) of selection dropdowns. You can change 

the Current Local namespace value at any time.  

2. Local attributes added in this manner to a concept or term in a subscription namespace 

are listed in italics in the Concept/Term Details panel view, as well as in the Concept 

Tree panel view (Container and Inline versions of the Ontylog Tree view). Note the 

illustration.  

 

 
 

3. The attributes themselves actually are written to the local namespace; no changes 

occur for the subscription namespace itself. 

4. The DTS Editor allows you to select or change the current local namespace at any time; it 

remembers the current local namespace the next time you connect to it. For your 

reference, the current local namespace always displays in the right-most panel of the 

Status Bar at the bottom of the DTS Editor Main window. 

 

For the purpose of adding local content, you can create property types, concept or term 

association types, and qualifier types in any local namespace. If you add instances of 

these types to a concept, the types do not have to reside in the same namespace as the 

target concept, but can be from any local namespace.  

Subscription 

Content Added to 

Local Namespace 
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Qualifier types, however, must reside in the same namespace as the property or 

association types they modify. 

5. Since the current local namespace may be changed, it is not necessary for local content 

for a subscription namespace to be stored in a single local namespace.  

6. Since properties, synonyms, and associations are attached directly to concepts in a 

namespace, you can retrieve these details along with the existing attributes of the 

concepts. In the DTS Editor, when you add or modify properties, synonyms, associations, 

or qualifiers of a subscription concept, the list of types (e.g. property types) will be those 

defined in the current local namespace, rather than those in the subscription namespace. 

 

D.3 Create a Local Namespace 
Follow this procedure to add a new local namespace to your knowledgebase. Note: To create a 

local namespace you must have the NAMESPACE_ADMIN permission. From the Menu select 

Tools > Namespace Editor. 

 

 
 

1. The Namespace Editor window will open. 
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2. To create a namespace click New. 
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3. The New Namespace window will open.  

 

 
 

4. In the Name field, type the desired name of your local namespace, i.e., LocalNS. 

 

 
 

5. The ID & Code fields are set to auto generate by default; this is the normal operation. If 

desired, however, specific values can be entered. 

 

 
 

6. The next field is the Authority field. Select the desired Authority for the namespace from 

the dropdown. If you wish to add a new Authority (or review the details of any 

Authority), click the Authority button. 
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7. The Authority Editor window will open. To add your organization as an Authority, click 

New. 

 

 
 

8. The New Authority window will open. In the Description field enter the name of your 

organization, i.e., MyOrg. The ID field will auto generate so leave it as is and click OK. 
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9. The authority you created will now be listed and the Local authority field will be 

checked, click Close. 

 

 
 

10. In the New Namespace window, click the dropdown next to the Authority field and 

choose your organization, i.e., MyOrg. 
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11. The Type field has (3) options, Ontylog, Thesaurus or Ontylog Extension namespace. 

• An Ontylog namespace is one that is created locally using the Ontylog language, 

for purposes of creating a taxonomy through classification.  This option is new to 

DTS 4.5.  Unlike Subscription Ontylog Namespaces, Local Ontylog Namespaces 

can be created as read-write and edited through the DTS Editor tools. 

• A Thesaurus namespace is one that is created from locally-defined data. For 

Thesaurus namespaces, concepts are organized based on relationships 

(associations) with other concepts. 

• An Ontylog Extension namespace is an extension of a specific Ontylog 

subscription namespace, created for the purpose of creating/maintaining new local 

content for the linked Ontylog subscription namespace, i.e., SNOMED CT. 

12. Based on your organization’s needs, choose the desired namespace type. 

 

 
 

13. The Linked Namespace field will be grayed out if you selected a Thesaurus namespace 

above. 

 

 
 

If you selected an Ontylog Extension namespace above you will need to choose the linked 

Subscription Ontylog namespace, e.g., SNOMED CT.  
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14. In the Permission field you have (2) Options Read-Write or Read-Only. If you want 

modelers to be able to edit and add information you will need to choose Read-Write.  

 

 
 

15. The Locality field is set to Local by default and is not editable. 

 

 
 

16. The Profile field lets you specify whether you want the Namespace initialized with a pre-

defined set of Namespace Attribute Types. These types are defined in a Namespace 

Profile object. If no Profile is desired, just leave the selection to  - None -; otherwise, 

select a Profile name from the dropdown. If you wish to add a new Profile (or review the 

details of any Profile), click the Profile button.  See the Namespace Profile View and 

Maintenance section for directions on use of the Profile Editor.   
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17. Based on your selections above your window should now look similar to the images 

below. Verify your field parameters and click OK. 
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18. The new namespace will be added and listed in the Namespace Editor Window, 

example images below. If desired, repeat this process to create additional namespaces.  

 

 

 
 

When you are done adding namespaces, Close the Namespace Editor. 
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D.4 View an Existing Namespace 
Follow this procedure to view information for an existing subscription namespace, or local 

namespace in your knowledgebase.   

 

1. From the Menu select Tools > Namespace Editor. 

 

 
 

2. The Namespace Editor window will open. 
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3. Information for each available namespace is listed in a table format. Information includes 

the namespace name and namespace type (Ontylog, Thesaurus, or Ontylog Extension). 

An indicator referencing if each namespace is a local namespace is included as well. For 

each listed Ontylog Extension namespace, the name of the Subscription Ontylog 

namespace that it Extends is referenced.  

 

The list of namespaces displayed in the Namespace Editor can be filtered based on the 

following parameters: 

 

Name  Namespaces whose names match the pattern in the entry field will be 

  displayed. Simple wildcards, e.g., “Subset*”, are supported.. 

 

Property All namespaces that include Property Filters naming the selected 

 Property will be displayed. 

Version   

Property All namespaces that include Version Property Filters naming the 

                    selected Version Property will be displayed. 

 

Extends All Ontylog Extension Namespaces that extend the selected base namespace 

 will be displayed 

 

 

 

You can resize the table columns. To change the sort for the namespace list, click the 
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column header for the characteristic (Namespace, Type, Local, or Extends) on which 

you want to base the sort.    

 

 
 

The table displaying the Namespace Editor parameters may be also be exported. The 

export respects any filters currently in use by the Namespace Editor. To export the 

contents displayed in the upper table view, click the Export button. Select Clipboard to 

copy the contents to your clipboard in order to transfer the data to other desktop 

applications. Select File to export the data as a locally saved .csv file. 

 

4. In the table listing, click the namespace you want to view to highlight the row. The data 

in the bottom portion of the window changes to reflect information from that namespace.  

 

 
 

• The Code provides additional namespace identification for an existing namespace 

and is not editable, regardless of whether it is a subscription or local namespace. 
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• The ID for an existing namespace is not editable, regardless of whether it is a 

subscription or local namespace.  

• A namespace is one of three types: Ontylog, Thesaurus, or Ontylog Extension. 

Each namespace may be a subscription namespace, or a local namespace. Refer 

to the Overview discussions under Namespace Maintenance for more on 

namespace types. 

• The namespace Locality indicates how the namespace data was acquired. 

Subscription indicates a load of namespace content into DTS through a 

subscription import. Local indicates the namespace was created using the DTS 

Editor, from DTS import utilities, or from user programs using the DTS API, for 

the purpose of using and maintaining local terminology content.  This field is not 

editable for existing namespaces.   

• The namespace Permission indicates whether or not the namespace is writable. 

The value (Read-Only or Read-Write) is set when the namespace is created.  For 

a local namespace, this value can only be edited by a user with 

NAMESPACE_MANAGE permission. Subscription namespaces are always 

Read-Only. 

• An authority indicates the organization (e.g., U.S. National Library of 

Medicine) that approved and/or certified a terminology. Refer to the Authority 

View and Maintenance discussions for procedures on viewing and creating 

authorities. 

When you finish viewing/editing namespaces, close the Namespace Editor window.   

 

D.5 Delete a Local Namespace 
Follow this procedure to delete an existing local namespace from your knowledgebase.  Note: To 

delete a local namespace you must be logged into the DTS Editor as a user with the 

NAMESPACE_ADMIN permission.  

 

1. From the Menu select Tools > Namespace Editor. 
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2. The Namespace Editor window will open. 
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3. In the namespace table listing, click the namespace you want to delete to highlight the 

row. The data in the bottom portion of the window changes to reflect information from 

that namespace. The Delete option is not available if you selected a subscription 

namespace. Click the enabled Delete button if you selected a local namespace for 

deletion 

 

 
 

4. A confirmation window similar to the following displays. This window will also display 

if there are Subsets that reference the namespace that is being deleted. If the namespace is 

deleted, any Subsets that reference the namespace in its expression will become invalid.  

 

 
 

5. Click OK to delete the namespace from the knowledgebase or click Cancel to ignore the 

deletion. 
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6. If you click OK, the namespace is deleted from the table in the Namespace Editor along 

with all concepts, terms, and associations from the namespace. A confirmation window 

similar to the following displays.  

 

 
 

Click OK and close the Namespace Editor window. 

 

D.6 Authority View and Maintenance 
A namespace authority indicates the organization (e.g., U.S. National Library of Medicine, 

U.S. Medical Terms Review) that approved or certified a terminology. An authority must be 

specified as part of each namespace (and subset) definition.  

 

Authorities can be viewed and managed within the Authority Editor. 
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The table displaying the Authority Editor parameters may be also be exported. To export the 

contents displayed in the upper table view, click the Export button. Select Clipboard to copy 

the contents to your clipboard in order to transfer the data to other desktop applications. Select 

File to export the data as a locally saved .csv file. 

D.6.1 Create an Authority 
Follow this procedure to create an authority that you can assign to a local namespace. Note: To 

create authority you must be logged into the DTS Editor as a user with the 

AUTHORITY_ADMIN permission.   

 

1. From the Menu select Tools > Authority Editor. 
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2. The Authority Editor window will display. 

 

 
 

3. Click the New button on the Authority Editor floating window.  
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4. The New Authority window displays.  

 

 
 

5. Specify the name of the authority for a local namespace in the Description field.  

In the ID field specifies the ID number of the authority for a local namespace. Leave this 

field blank to accept the auto-generated ID (the usual case), or enter the desired authority 

ID.  

 

 
 



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 74  

  

6. Click OK to update the knowledgebase with the new authority, or click Cancel to ignore 

the addition. If you click OK the authority will be added to the list. 

 

 

 

D.6.2 View an Existing Authority 
Follow this procedure to view information for an existing, local namespace authority.    

 

1. From the Menu select Tools > Authority Editor. 
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2. The Authority Editor window will display. 

 

 
 

3. To view the information about a specific Authority, click on the Authority name in the 

list in the Authority Editor floating window.  
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4. The information on each Authority is displayed in the bottom half of the Authority Editor 

window. The data in the window changes to reflect information from that authority.  

• The ID number assigned to this authority displays.  

• The locality of the Authority, Local or Subscription, displays.  

• The permission of the Authority (Read-Only or Read-Write). Subscription 

namespaces are Read-Only. 

 

5. Click Close when you are through viewing authority information, and to close the 

Authority Editor window. 

 

D.6.3 Delete an Authority  
Follow this procedure to view information for an existing, local namespace authority. Note: To 

delete an authority you must be logged into the DTS Editor as a user with the 

AUTHORITY_ADMIN permission.  

   

1. From the Menu select Tools > Authority Editor. 



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 77  

  

 
 

2. The Authority Editor window will display. 

 

 
 

3. To delete an Authority, click on the Authority name in the list in the Authority Editor 

floating window and click Delete. 
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4. A confirmation window similar to the following displays. 

 

 
 

5. Click OK to delete the authority from the knowledgebase. Click Cancel to ignore the 

deletion. If you click OK, a confirmation window similar to the following displays.  
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D.7 Namespace Profile View and Maintenance 
 

A Namespace Profile is a set of Namespace Attribute Types that are automatically added to a 

Namespace when the Namespace is created. The Namespace Profile Editor enables users to 

create, manage, and delete Namespace Profiles. Both User (specific to individual users) and 

System (accessible to all users) Profiles are available. Only users logged in with the 

“apelondtsadmin” role can create or edit system profiles.  

 

The Namespace Profile Editor is available from the DTS Editor Tools menu, as well as from the 

New Namespace panel.  

 

D.7.1 Create a Namespace Profile 
 

Follow this procedure to create a new namespace profile:  

 

1. From the Menu select Tools > Namespace Profile Editor, or click the Profile button in 

the New Namespace panel. 

 
 

2. After the Namespace profile Editor appears, click on the New button opposite the Profile 

field dropdown.  
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3. The New Namespace Profile window displays. Enter the name of new profile.  Then 

select if you wish to create a new profile from scratch, or import the settings of an 

existing profile (importing all existing attribute types, and allowing you to modify it 

further from that point),  and click OK to initialize a new profile, or click Cancel to 

ignore the addition. 

 

 
 

4. A new profile will be loaded into the New Namespace Profile window. If you chose to 

initialize your profile from an existing namespace, all the existing Association, Property, 

Qualifier, and Role Types, and Validators will be present in this new profile.  Created 

profiles are always user profiles, designated by a “(U)” following its name. Follow the 

steps in the View and Edit a Namespace Profile section below to complete the profile. 

Note that the profile will not be stored in the DTS Knowledgebase until the profile has 

been explicitly saved. 
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D.7.2 View and Edit a Namespace Profile 
Follow this procedure to view an existing namespace profile or edit the profile definition. 

 

1. From the Menu select Tools > Namespace Profile Editor, or click the Profile button in 

the New Namespace panel. 
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2. To view an existing namespace profile, click on the profile name in the Profile field 

dropdown.  

 

 
 

3. The information on the selected profile is displayed below the Profile field of the 

Namespace Profile Editor window. This information consists of:  

  
 

a. The description of the Profile.  

 
 

b. A set of tabs panels, each of which shows the attribute types, of the selected class 

(Association Type, Property Type, Qualifier Type Role Type, and Validator), to 
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be added to a created namespace. These tab panels, and the panel’s elements, are 

similar to those in the Attribute Type Editor described in the next section. See this 

section for further details on attribute type definitions. The rows in any of these 

tab panels can be sorted by clicking on the header of the desired sort column. 

  
 

4. To change the description of a Profile, edit the Description text field. 

5. To add, modify or remove an association type, select the Association Type tab.  

a. To add an association to the profile, click on the Add button at the bottom of the 

tab panel and enter the name of the association type to be created in the popup. 

Duplicate (case-insensitive) type names are not permitted.  
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i. As necessary, click in the Connects cell to select the Connects value for 

the new type.  

 
 

ii. Double click in the Inverse Name cell to enter an optional inverse name 

for the association. 

 
 

b. To modify an existing profile association, double click in the Name cell to edit 

the association type name, click in the Connects cell to change the Connects 

value for the type, or double click in the Inverse Name cell to modify (or 

remove) an optional inverse name for the type. Duplicate (case-insensitive) type 

names are not permitted.  

 
 

c. To remove an association type from the profile, select the association in the table 

and click on the Remove button.  
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i. A confirmation dialog will be shown.  

 
 

ii. Click OK to remove the association type, or Cancel to cancel the 

operation. 

 
 

6. To add, modify or remove a property type, select the Property Type tab. 

a. To add a property to the profile, click on the Add button at the bottom of the tab 

panel and enter the name of the property type to be created in the popup. 

Duplicate (case-insensitive) type names are not permitted.  
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i. As necessary, click in the Modifies cell to select the Modifies value for 

the new type.  

 
 

 

b. To modify an existing profile property, double click in the Name cell to edit the 

property type name, click in the Modifies cell to change the Modifies value for 

the type. Duplicate (case-insensitive) type names are not permitted.  

 
 



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 87  

  

c. To remove a property type from the profile, select the property in the table and 

click on the Remove button.  

 
 

i. A confirmation dialog will be shown.  

 
 

ii. Click OK to remove the property type, or Cancel to cancel the operation. 

7. To add, modify or remove a qualifier type, select the Qualifier Type tab. 

a. To add a qualifier to the profile, click on the Add button at the bottom of the tab 

panel and enter the name of the qualifier type to be created in the popup. 

Duplicate (case-insensitive) type names are not permitted.  
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i. As necessary, click in the Qualifies cell to select the Qualifies value for 

the new type.  

 
 

 

b. To modify an existing profile qualifier, double click in the Name cell to edit the 

qualifier type name, click in the Qualifies cell to change the Qualifies value for 

the type. Duplicate (case-insensitive) type names are not permitted.  
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c. To remove a qualifier type from the profile, select the qualifier in the table and 

click on the Remove button.  

 
 

i. A confirmation dialog will be shown.  

 
 

ii. Click OK to remove the qualifier type, or Cancel to cancel the operation. 

8. To add, modify, or remove a kind, select the Kind tab. 

a. Note that if any Kinds are entered in this tab, the resulting profile can only be 

applied to a Local Ontylog, or Ontylog Extension namespace. 

b. To add a Kind to the profile, click on the Add button at the bottom of the tab 

panel and enter the name of the Kind to be created in the popup.  Duplicate (case-

insensitive) kind names are not permitted.  
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c. To modify an existing profile kind, double click in the Name cell to edit the kind 

name. Duplicate (case-insensitive) type names are not permitted.  

 
 

d. To remove a kind from the profile, select the kind in the table and click on the 

Remove button.  
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i. A confirmation dialog will be shown.  

 
 

ii. Click OK to remove the kind, or Cancel to cancel the operation. 

 

9. To add, modify or remove a role type, select the Role Type tab. 

a. Note that if any Role Types are entered in this tab, the resulting profile can only 

be applied to an Ontylog Extension namespace. 

b. To add a Role Type to the profile, click on the Add button at the bottom of the tab 

panel and enter the name of the Role Type to be created in the popup. Duplicate 

(case-insensitive) type names are not permitted.  
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i. As necessary, click in the Domain, Range, Right Identity, and Parent 

Role Type cells to select the desired values for the new type. Domain and 

Range are required. 

 
c. To modify an existing profile Role, double click in the Name cell to edit the Role 

name. Duplicate (case-insensitive) type names are not permitted.  

 
 

d. To remove a Role from the profile, select the kind in the table and click on the 

Remove button.  
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i. A confirmation dialog will be shown.  

 
 

ii. Click OK to remove the kind, or Cancel to cancel the operation. 

10. To add, modify or remove a validator type, select the Validator Type tab. 

a. To add a Validator Type to the profile, click on the Add button at the bottom of 

the tab panel and enter the name of the Validator Type to be created in the popup. 

Duplicate (case-insensitive) type names are not permitted.  
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i. As necessary, click in the Method, Value(s), ToolTip, and Error Text 

cells to select the desired values for the new type. Method and Value(s) 

are required. 

 
b. To modify an existing profile Validator, double click in the Name cell to edit the 

Role name. Duplicate (case-insensitive) type names are not permitted.  

 
 

c. To remove a Validator from the profile, select the kind in the table and click on 

the Remove button.  
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i. A confirmation dialog will be shown.  

 
 

ii. Click OK to remove the validator, or Cancel to cancel the operation. 

11. To discard any pending changes and return to the last saved version of the profile, click 

the Restore button. 
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12. Click Save (which becomes enabled if you make an edit) to update the selected 

Namespace profile with the changes.  

  
 

13. Click Cancel to close the Namespace Profile Editor window. 

 

 
 

D.7.3 Copy a Namespace Profile 
Follow this procedure to copy a namespace profile to a new profile. The original profile will be 

unchanged after the operation. 

1. From the Menu select Tools > Namespace Profile Editor, or click the Profile button in 

the New Namespace panel. 
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2. Select the namespace profile to be copied from the Profile field dropdown and click the 

Copy button at the bottom of the panel. 

 
 

3. Enter the name of the new profile to be created in the Profile Name field of the Copy 

Profile dialog box. Click OK to copy the profile or click Cancel to cancel the operation. 

If the entered name is already in use, an error dialog will be shown. 

4. If you are logged in with the “apelondtsadmin” role, a dialog appears giving you the 

option to create the Namespace Profile copy as a system profile. Click on the preferred 

button to save the profile. 



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 98  

  

 
 

5. Click Cancel to close the Namespace Profile Editor window. 

D.7.4 Rename a Namespace Profile 
Follow this procedure to rename a namespace profile. 

1. From the Menu select Tools > Namespace Profile Editor, or click the Profile button in 

the New Namespace panel. 

 
 

2. Select the namespace profile to be renamed from the Profile field dropdown and click the 

Rename button at the bottom of the panel. 
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3. Enter the new name of the profile in the Profile Name field of the Rename Profile 

dialog box. Click OK to rename the profile or click Cancel to cancel the operation. If the 

entered name is already in use, an error dialog will be shown. 

4. Click Cancel to close the Namespace Profile Editor window. 

D.7.5 Delete a Namespace Profile 
 

1. From the Menu select Tools > Namespace Profile Editor, or click the Profile button in 

the New Namespace panel. 
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2. Select the namespace profile to be deleted from the Profile field dropdown and click the 

Delete button at the bottom of the panel. 

 
 

3. Click OK to delete the namespace profile from the system. Click Cancel to cancel the 

operation. 

4. Click Cancel to close the Namespace Profile Editor window. 

 

D.7.6 Export a Namespace Profile 
Namespace user profiles are only visible to the user that created the profile. To exchange one of 

your profile definitions so that it can be used by other users, the profile can be exported to an xml 

file in your local file system. The profile can then be sent to other users and imported as one of 

their profiles (or as a system profile). See Import a Namespace Profile below for information 

on importing. 

 

Follow this procedure to export a namespace profile. 

1. From the Menu select Tools > Namespace Profile Editor, or click the Profile button in 

the New Namespace panel. 
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2. Select the namespace profile to be exported from the Profile field dropdown and select 

the Export item in the Namespace Profile Editor’s File menu. 

 
 

3. The Export Profile file chooser dialog is shown. Browse to the desired file location and 

enter the desired file name. The file must have an “.xml” extension.  
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4. Click the Save button to export the profile to the selected file or Cancel to cancel the 

operation. 

5. Click Cancel to close the Namespace Profile Editor window. 

D.7.7 Import a Namespace Profile 
Profile definitions can be imported to the Namespace Profile Editor from xml files produced by 

the above profile export process.  Once imported, these profiles can be saved as new user 

profiles, or, if the user has the “apelondtsadmin” role, as new system profile. 

 

Follow this procedure to export a namespace profile. 

1. From the Menu select Tools > Namespace Profile Editor, or click the Profile button in 

the New Namespace panel. 
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2. Select the namespace profile to be imported from the Profile field dropdown and select 

the Import item in the Namespace Profile Editor’s File menu. 

 
 

3. The Export Profile file chooser dialog is shown. Browse to the desired file location and 

select the desired file. The file must have an “.xml” extension.  
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4. Click the Open button to import the selected file into a new profile or Cancel to 

cancel the operation. 

5. Enter the name of the profile to be created in the Profile Name field of the Import 

Profile dialog box. Click OK to copy the profile or click Cancel to cancel the 

operation. If the entered name is already in use, an error dialog will be shown. 

 
 

6. Click Cancel to close the Namespace Profile Editor window. 
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E. Assign Permissions to Newly Created Namespaces 
After you create a new namespace you will need to open the User Manager module and grant 

permissions to each user that you want to have Write or Manage permissions. By default, all 

users receive Read access. Note: To open the User Manager you must be logged into the DTS 

Editor as a user with the “apelondtsadmin” role, i.e., dtsadminuser / dtsadmin.  

 

1. From the menu select Options > User Manager. 

 

 
 

2. After selecting the User Manager, the DTS User Manager window displays. From the 

Role Defs tab, select the Role to which you want to add the new permission. In the 

example below we have selected the role named SuperUser. (See the User Manager 

Guide for details on creating and managing DTS Roles and Permissions). You can review 

the current permissions assigned to the new namespaces you created.  
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3. With the SuperUser role selected in the top section, grant Manage permissions to each 

desired local namespace and click Save. 
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4. Similarly, with the Modeler role selected in the top section, grant Write permissions to 

each desired local namespace and click Save. 



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 108  
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F. Attribute Type Maintenance 
The Attribute Type Editor panel consolidates the management of Attribute Types (metadata) for 

all Namespaces in the knowledgebase. The Attribute Type Editor panel provides a two-tier tab 

structure to accommodate the different kinds of available metadata (see screen shots below). The 

top level of tabs name the primary DTS object that holds attributes: Namespaces, Subsets and 

Authorities. Within each of these tabs, the second level tabs are used to select the specific 

Attribute Types to be created, displayed or modified:  

• For Namespaces: Association Types, Property Types, Qualifier Types, Kinds, Role Types 

and Validators 

• For Subsets: Property Types and Qualifier Types 

• For Authorities: Property Types and Qualifier Types 

The sections below describe the procedures for managing the Attribute Types associated with 

Namespaces (from the Namespace tab). Procedures for Subset and Authority Attribute Types are 

similar. 

 

F.1 Association Types 
This section includes basic procedures for creating and maintaining associations between 

concepts (concept associations), between terms (term associations) or between concepts and 

terms (synonym associations). An association type (e.g., Related To) is assigned to each 

association between concepts or terms to define the nature of the association. An association may 

also have a qualifier, which provides additional detail regarding the nature of the association 

(e.g., Usually). Procedures for creating and maintaining association types and qualifiers are 

included as well.  

 

In a writable namespace you can create associations between concepts and terms that reside in 

one namespace (writable or not) or create associations between concepts and terms across 

namespaces. 

F.1.1 Create Association Types 
Each association you create must be assigned a specific type to indicate the nature of the link 

(e.g., one concept is Broader Than the other, or is a Parent of the other). The following 

procedures pertain to creating and maintaining association types. 

 

Follow this procedure to add one or more new association types to an editable namespace. 

 

1. From the Menu select Tools > Attribute Types. 
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2. The Attribute Type window displays. The window initially opens with the Namespace tab 

selected and All selected in the Namespace dropdown. This shows the types from all 

namespaces in the DTS knowledgebase. To limit the displays to a single namespace, 

select that namespace from the dropdown. Note that the panel remembers the selected 

namespace (or subset/authority) between invocations.) 

 

  
 

3. To create a new Association Type, select the Association Type tab and click New. 
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4. The fields at the bottom of the Attribute Type Editor are activated. 
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5. In the Name field, type the name of the Association Type. 

 

 
 

6. The association type ID is generated automatically, and displayed in the ID field. You 

cannot modify the generated association type ID.  

 

 
 

In the Namespace dropdown field, select the local, editable namespace in which you are 

creating this association type, i.e. LocalNS. Only local namespaces are included in the 

list. If a namespace was selected in the top Namespace dropdown, this namespace will be 

pre-selected.  

 

 
 

7. The value in the Connects dropdown field indicates if the association type represents a 

connection between Two Concepts, between a concept and a synonym (Concept With 

Synonymous Term) or Two Terms. Select the kind of connection this association type 

represents. 
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8. The Inverse Name describes the inverse relationship of this association, and displays 

when you view Inverse Concept Associations (e.g., when you perform a search). For 

example, "Is Narrower Than" is the inverse of "Is Broader Than" or “Child Of” is the 

inverse of “Parent Of”. Inverse Name is optional. 

 

 
 

 

9. For Property and Qualifier type attributes, you also have the option of assigning a 

Validator.  Validators can be defined in the “Validator” tab, and allow you to restrict the 

string input to match rules based on a regex or predefined dropdown list.  See the 

“Validators” section below for more information on defining Validators.  

 

10. Click Apply to update the selected local namespace with the new association type; the 

new association type is added to the table on the Attribute Type Editor > Association 

Type window.  You can click New again and create additional association types in the 

local namespace. 

When you finish creating association types, click Close to close the Attribute Type Editor 

window. 

F.1.2 View and Edit an Association Type 
Follow this procedure to view information for an existing association type that exists in any 

namespace, and edit the information if the association type was created in a local, writable 

namespace.  You can also filter Attribute Types for easier viewing/editing using the Name Filter 

tool, or view them all by clicking the “All” radial button. 

 

1. From the Menu select Tools > Attribute Types. 



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 114  

  

 

 
 

2. The Attribute Type Editor window displays.  

 

 
 

Select the Association Type tab. To change the sort for the association type list, click the 

column header for the characteristic (Association Type, Namespace, or Connects) on 

which you want to base the sort.  

 

3. In the association type table listing, click the association type you want to view or modify 

to highlight the row. The lower portion of the window changes to reflect information 

from that association type. If the association type you selected was created in a 
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subscription namespace, none of the fields are editable. If the association type was 

created in a local, writable namespace, the editable fields are enabled. 

 

 
 

4. In the Name field, modify the association type name, as necessary. 

 

 
 

5. The ID that was generated when the association type was created displays; the ID is not 

editable, for any type of namespace. 

 

 
 

6. The Namespace in which the association type was created is not editable, for any type of 

namespace. 

 

 
 

7. The value in the Connects dropdown field indicates if the association type represents a 

connection between Two Concepts, between a concept and a synonym (Concept With 

Synonymous Term), or Two Terms. The value in the Connects field is editable as long 

as this is an association type that was created in a writable namespace, and no instances 

of this association type exist.  
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8. The Inverse Name describes the inverse relationship of this association, and displays 

when you view Inverse Concept Associations (e.g., when you perform a search). For 

example, "Is Narrower Than" is the inverse of "Is Broader Than" or “Child Of” is the 

inverse of “Parent Of”. 

 

 
 

9. Click Apply (which becomes enabled if you make an edit) to update the selected local 

namespace with the association type edits; the Attribute Type Editor window remains 

displayed for additional edits and/or additions.  

10. Click Close to close the Attribute Type Editor window. 

F.1.3 Delete an Association Type  
Follow this procedure to delete an existing association type that was created in a local, writable 

namespace. If there are associations that exist with this association type, you will not be 

permitted to delete the association type.  

 

Follow this procedure to view information for an existing association type that exists in any 

namespace, and edit the information if the association type was created in a local, writable 

namespace.   

 

1. From the Menu select Tools > Attribute Types. 

 

 
 

2. The Attribute Type Editor window displays.  
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Select the Association Type tab. To change the sort for the association type list, click the 

column header for the characteristic (Association Type, Namespace, or Connects) on 

which you want to base the sort.  

 

3. In the association type table listing, click the association type you want to delete and click 

Delete. 
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4. A window similar to the following displays if associations with this type exist in a local 

namespace.  

 

 
 

5. As long as associations of this type exist, you will not be permitted to delete the 

association type. If no associations with this type exist, a delete confirmation window 

similar to the following displays. 
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6. Click OK to delete the association type from the namespace in which it was created; the 

association type is removed from the table on the Attribute Type Editor window in the 

Association Type tab. Click Cancel to ignore the deletion. 

7. Click Close to close the Attribute Type Editor window. 

 

F.2 Property Types 
A property is user-definable metadata that can be used for any purpose and can be added to 

Concepts, Terms, Namespaces, Versions, and Authorities. Properties are available for both 

Subscription and Local DTS Objects. Properties allow for the creation of more expressive 

objects including definitions, provenance, OIDs, URIs, etc. For example, a property can be a 

textual definition for a concept, or can identify the source terminology where a term originated. 

A property type (i.e., definition) is assigned to each property to define the nature of the property. 

One or more qualifier types and values can be assigned to each property as well.  

 

All Property values may contain up to 4,000 characters, the first 255 characters of which are 

automatically indexed. 

F.2.1 Create Property Types 
Follow this procedure to add a new property type to a local namespace. You then can assign the 

property type to a concept in any local namespace, or add the property type (as local content) for 

a concept in a subscription namespace. 

 

Follow this procedure to add one or more new property types to an editable namespace. 

 

1. From the Menu select Tools > Attribute Types. 

 

 
 

2. The Attribute Type window displays.  
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3. To create a new Property Type, select the Property Type tab and click New. 
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4. The fields at the bottom of the Attribute Type Editor are activated. 

 

 
 

5. In the Name field, type the name of the Property, i.e., Code in Source. 

 

 
 

6. The property type ID is generated automatically, and displayed in the ID field. You 

cannot modify the generated property type ID.  

 

 
 

In the Namespace dropdown field, select the local, editable namespace in which you are 

creating this property type, i.e. LocalNS. Only local namespaces are included in the list. 

If a namespace was selected in the top Namespace dropdown, this namespace will be pre-

selected.  

 

 
 

7. From the Modifies field dropdown list, indicate what the property type will be assigned 

to, either a Concept, Namespace, Term, or a Version. 
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8. Click Apply to update the selected local namespace with the new property type; the new 

property type is added to the table on the Attribute Type Editor > Property Type window.  

You can click New again and create additional property types in the local namespace. 

 

When you finish creating property types, click Close to close the Attribute Type Editor window. 

F.2.2 View and Edit a Property Type 
Follow this procedure to view information for an existing association type that exists in any 

namespace, and edit the information if the property type was created in a local, writable 

namespace.   

 

1. From the Menu select Tools > Attribute Types. 

 

 
 

2. The Attribute Type Editor window displays. 
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Select the Property Type tab. To change the sort for the property type list, click the 

column header for the characteristic (Property Type, Namespace, or Modifies) on 

which you want to base the sort.  

 

3. In the property type table listing, click the property type you want to view or modify to 

highlight the row. The lower portion of the window changes to reflect information from 

that property type. If the property type you selected was created in a subscription 

namespace, none of the fields are editable. If the association type was created in a local, 

writable namespace, the editable fields are enabled. 
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4. In the Name field, modify the property type name, as necessary.  

 

 
 

5. The ID that was generated when the association type was created displays; the ID is not 

editable, for any type of namespace. 

  

 
 

6. The Namespace in which the association type was created is not editable, for any type of 

namespace.  

 

 
 

7. From the Modifies field dropdown list, indicate what the property type will be assign to, 

either a Concept, Namespace, Term, or a Version. Change the Modifies field, as 

necessary. The Modifies field will only be editable if instances of the property type do not 

already exist in the knowledgebase. 
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8. Click Apply (which becomes enabled if you make an edit) to update the selected local 

namespace with the association type edits; the Attribute Type Editor window remains 

displayed for additional edits and/or additions.  

 

9. Click Close to close the Attribute Type Editor window. 

F.2.3 Delete an Property Type  
Follow this procedure to delete an existing property type that was created in a local, writable 

namespace. If there are properties that exist with this property type, you will not be permitted to 

delete the property type.  

 

Follow this procedure to delete a property type that exists in a local, writable namespace. 

 

1. From the Menu select Tools > Attribute Types. 

 

 
 

2. The Attribute Type Editor window displays.  
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Select the Property Type tab. To change the sort for the property type list, click the 

column header for the characteristic (Property Type, Namespace, or Modifies) on 

which you want to base the sort.  

 

3. In the Property Type table listing, click the property type you want to delete and click 

Delete. 
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4. A window similar to the following displays if properties with this type exist in a local 

namespace.  

 

 
 

5. As long as properties of this type exist, you will not be permitted to delete the property 

type. If no properties with this type exist, a delete confirmation window similar to the 

following displays. 
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6. Click OK to delete the property type from the namespace in which it was created; the 

property type is removed from the table on the Attribute Type Editor window in the 

Property Type tab. Click Cancel to ignore the deletion. 

 

Click Close to close the Attribute Type Editor window. 

 

F.3 Qualifier Types 
For each association or property you can specify (optionally) an established qualifier type and 

value. 

 

For an association type, a qualifier provides additional detail regarding the nature of a concept or 

term association (for example, the origin of an association, or the degree of accuracy of a 

mapping between concepts, such as Usually). You can assign a qualifier type and value to each 

association between concepts or terms.  

 

For a property type, a qualifier provides additional detail regarding the nature of a concept or 

term property (e.g., a property effective date, or an indicator reflecting that the property is 

Current). You can assign a type and value to each concept or term property qualifier.  

The following procedures pertain to creating and maintaining qualifier types. 

F.3.1 Create Association Qualifier Types 
Follow this procedure to add one or more new qualifier types to a local, editable namespace. 

 

1. From the Menu select Tools > Attribute Types. 

 

 
 

2. The Attribute Type Editor window displays. Select the Qualifier Type tab.  
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Information for existing qualifier types (for both associations and properties) is listed in a 

table format in columns you can resize. Qualifier types from both writable and non-

writable namespaces are listed.  

 

Table information includes the qualifier type name, the namespace in which the qualifier 

was created, and an indicator that references the kind of association it qualifies, either 

Concept Association or Term Association (the Concept Property and Term Property 

values relate to qualifier types for concept and term properties). To change the sort for 

the qualifier type list, click the column header for the characteristic (Qualifier Type, 

Namespace, or Qualifies) on which you want to base the sort. 
 

3. Click New. The fields in the lower portion of the window are enabled. 



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 130  

  

 

 
 

4. Specify a name for the new association qualifier type in the Name field, i.e., Effective 

Date. 

 

 
 

5. The qualifier type ID is generated automatically, and displayed in the ID field. You 

cannot modify the generated qualifier type ID.  

 

 
 

6. From the Namespace field dropdown list, select the local namespace to which this 

association or property qualifier type should be written. Since a qualifier type can be 

written to editable namespaces only, only these namespaces are included in the list, i.e., 

LocalNS. If a namespace was selected in top Namespace dropdown, this namespace will 

be preselected. 
 

 
 

7. The value you select in the Qualifies field dropdown list indicates the kind of association 

this qualifier type will qualify. The Qualifies field will only be editable if instances of the 

association type do not already exist in the knowledgebase. 
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• Select Concept Property for a qualifier of a property on a concept. 

• Select Concept Association for a qualifier of an association between two 

concepts. 

• Select Namespace Property for a qualifier of a property on a Namespace. 

• Select Term Property for a qualifier of a property on a term. 

• Select Term Association for a qualifier of an association between two terms. 

• Select Version Property for a qualifier of a property on a Namespace Version. 
 

8. Click Apply to update the selected local namespace with the new qualifier type. 

 

 
 

9. The new qualifier type is added to the table on the Attribute Type Editor window > 

Qualifier Type tab. The Attribute Type Editor window remains displayed; click New 

again to create additional qualifier types in the local namespace. 
 



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 132  

  

10. Click Close to close the Attribute Type Editor window. 

  



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 133  

  

F.3.2 View and Edit a Qualifier Type 
Follow this procedure to view information for an existing qualifier type, and to perform any 

required edits. 

 

1. From the Menu select Tools > Attribute Types. 

 

 
 

2. The Attribute Type Editor window displays. Select the Qualifier Type tab.  
 

 
 

Information for existing qualifier types (for both associations and properties) is listed in a 

table format in columns you can resize. Qualifier types from both writable and non-
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writable namespaces are listed.  

 

Table information includes the qualifier type name, the namespace in which the qualifier 

was created, and an indicator that references the kind of association it qualifies, either 

Concept Association or Term Association (the Concept Property and Term Property 

values relate to qualifier types for concept and term properties). To change the sort for 

the qualifier type list, click the column header for the characteristic (Qualifier Type, 

Namespace, or Qualifies) on which you want to base the sort. 
 

3. In the qualifier type table listing, click the qualifier type you want to view or modify to 

highlight the row. The data in the bottom portion of the window changes to reflect 

information for that qualifier.  

 

 
 

4. If the qualifier type was created in a local (writable) namespace, you can modify the 

qualifier type Name, as needed. The Name is not editable if the qualifier type is from a 

subscription namespace. 

 

 
 

5. The ID generated for the qualifier type when it was created displays. The field is not 

editable. 
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6. The Namespace in which this qualifier type was created displays. The field is not 

editable. 

 

 
 

7. The value in the Qualifies field indicates what this qualifier type will qualify (the field is 

not editable, regardless of the namespace in which the qualifier type was created). The 

Qualifies field will only be editable if instances of the qualifier type do not already exist 

in the knowledgebase. 

 

 
 

• A Concept Property for a qualifier of a property on a concept. 

• A Concept Association for a qualifier of an association between two concepts. 

• A Namespace Property for a qualifier of a property on a Namespace. 

• A Term Property for a qualifier of a property on a term. 

• A Term Association for a qualifier of an association between two terms. 

• A Version Property for a qualifier of a property on a Namespace Version. 

8. Click Apply (which becomes enabled if you make an edit) to update the selected local 

namespace with the qualifier type edits; the Attribute Type Editor window > Qualifier 

Type tab remains displayed if you want to view or edit other qualifier types. 

9. Click Close to close the Attribute Type Editor window 
 

F.3.3 Delete an Association Qualifier Type 
Follow this procedure to delete an existing qualifier type from a local namespace. The qualifier 

type must have been created in a local (i.e., writable) namespace in order for you to delete it.  

 

1. From the Menu select Tools > Attribute Types. 
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2. The Attribute Type Editor window displays. Select the Qualifier Type tab.  

 
 

Information for existing qualifier types (for both associations and properties) is listed in a 

table format in columns you can resize. Qualifier types from both writable and non-

writable namespaces are listed.  

 

Table information includes the qualifier type name, the namespace in which the qualifier 

was created, and an indicator that references the kind of association it qualifies, either 

Concept Association or Term Association (the Concept Property and Term Property 

values relate to qualifier types for concept and term properties). To change the sort for 
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the qualifier type list, click the column header for the characteristic (Qualifier Type, 

Namespace, or Qualifies) on which you want to base the sort. 
 

3. In the qualifier type table listing, click the qualifier type you want to view or modify to 

highlight the row. The data in the bottom portion of the window changes to reflect 

information for that qualifier.  

 
 

4. In the Qualifier Type table listing, click the qualifier type you want to delete and click 

Delete. 
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5. If an instance of this qualifier with this type already exists in the local namespace, the 

qualifier type cannot be deleted. An informational dialog will be shown. 

 
 

6. As long as qualifiers of this type exist, you will not be permitted to delete the qualifier 

type. If no qualifiers with this type exist, a delete confirmation window similar to the 

following displays.  
 

 

 
 
 

7. Click OK to delete the association type from the namespace in which it was created; the 

association type is removed from the table on the Attribute Type Editor window in the 

Association Type tab. Click Cancel to ignore the deletion. 
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8. Click Close to close the Attribute Type Editor window. 

 

F.3.4 Validators 
 

Using the new Validators tool, you can define a set of parameters to restrict the string input for 

Property and Qualifier type attributes.  Validators can be defined one of two ways: LIST, or 

REGEX.  To create a validator, first click the Validator tab button in the Attribute Type Editor. 

 

 

Validators are Namespace-specific, and cannot be created for “all” namespaces.  Be sure a 

namespace is selected in the “Namespace” field. 

Click “New” to begin defining your Validator.  Next assign your Validator a name, e.g. “Date” or 

“My List”.  In the “Method” field, select the type of Validator you wish to create.  You can choose 

either LIST, if you wish to define a pick list of options for the validator, or REGEX to use a regular 

expression to define the restriction on the string input, like a date field, or alpha-numeric characters 

only.  Depending on your Method selection, the corresponding fields below will activate or 

deactivate. 
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If you selected LIST, you can then manually enter, or copy paste, your list of values in the “Value 

List” field.  Entries are separated in this field with a carriage return, with each option simply on its 

own line in the text box. 

 

If you selected REGEX, you can then define the regular expression to control the string input.  If 

you need assistance with your regex definition, the “Test” button will launch a small RegEx Helper 

dialog box.  You can enter a regex here, and a test value, and click “test” to see if the value meets 

the RegEx definition. 

 

For Example, below we have defined a numeric digits-only format in the helper, but typed a 

character value in the “value” field.  Clicking Test displays a message that ‘s’ does not match the 

RexEx pattern, as it is not numeric digits.   

 

If we instead enter valid data and click “test” a message of ‘valid input’ is displayed instead. 

 

In the RegEx Helper, there is also a Reference tab with helpful hints and examples of commonly 

used RexEx patterns. 
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Once you have defined your RegEx in the RegEx Helper, you can click “Apply” to copy the value 

into the Regex field on the Validator screen. 

Back on the Validator Screen you can also define a ToolTip, which will display text on mouseover 

of the field to hint to the user what the field expects. 

You can also define a custom error message to display in the event the user does not match the 

pattern, to prompt the user to edit their entry accordingly. (see below for a sample validator 

definition.  Note in the REGEX example the “Value List” field is greyed out, and in the LIST 

example the “Regex” field is greyed out.  The historical data present in each of these fields will 

have no effect on the functions of the validator of the opposite Method). 

RegEx Example: 
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List Example: 
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F.4 Kinds 
For and Ontylog Namespace, a Kind is used in the definition of the concepts within the 

namespace.  With the support for Local Ontylog Namespaces, the Attribute Types editor now 

supports creating and editing Kinds for these namespaces. 

F.4.1 Create Kinds 
Follow this procedure to add one or more new kinds to an editable Ontylog Namespace. 

 

11. From the Menu select Tools > Attribute Types. 

 

 
 

12. The Attribute Type Editor window displays. Select the Kind tab.  
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Information for existing kinds, if any (for both associations and properties) is listed in a 

table format in columns you can resize. Kinds are namespace-specific, and you must 

select a namespace in the dropdown before you can make changes. You cannot create 

kinds for “all” namespaces. 

 

Table information includes the kind name and the namespace in which the kind was 

created.  To change the sort for the kind list, click the column header for the characteristic 

on which you want to base the sort. 
 

13. Click New. The fields in the lower portion of the window are enabled. 

 

 
 

14. Specify a name for the new kind in the Name field, i.e., Procedure Kind. 

 

 
 

15. The kind ID is generated automatically, and displayed in the ID field. You cannot modify 

the generated kind ID.  

 

 
 

16. The Namespace dropdown field is auto-populated with the selected Namespace from 

above, and cannot be edited. 

 

 
 

17. Click Apply to update the selected local Ontylog Namespace with the new Kind. 
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18. The new Kind is added to the table on the Attribute Type Editor window > Kind tab. The 

Attribute Type Editor window remains displayed; click New again to create additional 

qualifier types in the local namespace. 
 

19. Click Close to close the Attribute Type Editor window. 
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F.4.2 View and Edit a Kind 
Follow this procedure to view information for an existing Kind, and to perform any required 

edits. 

 

10. From the Menu select Tools > Attribute Types. 

 

 
 

11. The Attribute Type Editor window displays. Select the Kind tab.  
 

 
 

Information for existing kinds, if any (for both associations and properties) is listed in a 
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table format in columns you can resize. Kinds are namespace-specific, and you must 

select a namespace in the dropdown before you can make changes. You cannot create 

kinds for “all” namespaces. 

 

Table information includes the kind name and the namespace in which the kind was 

created.  To change the sort for the kind list, click the column header for the characteristic 

on which you want to base the sort. 

 
 

12. In the kind table listing, click the kind you want to view or modify to highlight the row. 

The data in the bottom portion of the window changes to reflect information for that kind.  

 

 
 

13. If the kind was created in a local ontylog namespace, you can modify the qualifier type 

Name, as needed. The Name is not editable if the kind is from a subscription ontylog 

namespace. 

 

 
 

14. The ID generated for the kind when it was created displays. The field is not editable. 

 

15. The Namespace in which this kind was created displays. The field is not editable. 
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16. Click Apply (which becomes enabled if you make an edit) to update the selected local 

ontylog namespace with the kind edits; the Attribute Type Editor window > Kind tab 

remains displayed if you want to view or edit other kinds. 

17. Click Close to close the Attribute Type Editor window 
 

F.4.3 Delete a Kind 
Follow this procedure to delete an existing kind from a local ontylog namespace. The kind must 

have been created in a local ontylog namespace in order for you to delete it.  

 

9. From the Menu select Tools > Attribute Types. 

 

 
 

10. The Attribute Type Editor window displays. Select the Kind tab.  
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Information for existing kinds, if any (for both associations and properties) is listed in a 

table format in columns you can resize. Kinds are namespace-specific, and you must 

select a namespace in the dropdown before you can make changes. You cannot create 

kinds for “all” namespaces. 

 

Table information includes the kind name and the namespace in which the kind was 

created.  To change the sort for the kind list, click the column header for the characteristic 

on which you want to base the sort. 

 
 

11. In the kind table listing, click the kind you want to view or modify to highlight the row. 

The data in the bottom portion of the window changes to reflect information for that kind.  
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12. In the Kind table listing, click the kind type you want to delete and click Delete.  A 

confirmation window will pop up allowing you to confirm deletion. 
   

 
 

13. If an instance of this qualifier with this type already exists in the local namespace, the 

qualifier type cannot be deleted. An informational dialog will be shown. As long as 

concepts in the Local Ontylog Namespace exist with this kind, you will not be permitted 

to delete the kind.  
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14. Click OK to delete the kind from the namespace in which it was created; the kind is 

removed from the table on the Attribute Type Editor window in the Association Type tab. 

Click Cancel to ignore the deletion. 

 

15. Click Close to close the Attribute Type Editor window. 

G. Details Panel 
The Details panel centralizes edit functionality via independent tabs for Concepts, Terms, 

Namespaces, Subsets, and Authorities. Each tab supports the addition, modification, and deletion 

of Properties and other Attributes for these objects. The visibility of the tabs and their 

modifiability can be customized in the DTS Editor Layout file (refer to the DTS Editor Module 

Guide for additional information). In the Details panels, double clicking on a container node—a 

node that contains additional concepts—toggles expansion, similar to clicking on the little + 

icon. Double clicking on a leaf node—a node that does not contain additional concepts—opens 

the editor for the leaf, provided that the node is editable. 

 

In addition to the right-click context menu functions in the Details Panel, DTS also supports 

Windows standard keyboard shortcuts for Cut (Ctrl+X), Copy (Ctrl+C) and Paste (Ctrl+V) to 

facilitate the ease of editing all attributes. 

 

New to the Details panel in Version 4 is a Version Select widget to move between Concept 

“snapshots” in Namespace Versions. This is similar to the Version Select widget in the Tree and 

Search panels. The Concepts and Term “trees” also now include an Active/Inactive/Deleted 

status attribute. This attribute is read-write on Concepts/Terms in Thesaurus and Ontylog 

Extension Namespaces. Right click on the Status line to edit this value. The configuration menu 

now includes Status and History ToolTip items. If selected, the latter shows Concept/Term and 

Attribute Created/Retired dates and associated username in ToolTips. Inverse Synonyms (the 

Concepts associated with a Term via a Synonymous relationship) are now displayed on Terms. 

Drag and Drop is supported on all objects.  

 

The Namespaces, Subsets and Authorities panels incorporate an editable “details” panel. This 

panel replicates all display and editing features of the equivalent Namespace, Subset and 

Authority Editor Panels. There are a few functionality differences, however, in particular the 

Publish operation is only available in the Namespace and Edit Panels.  

 

A new “print” option is available to produce hard copy of the information in a Details panel 

(including those panels embedded in the Namespace Editor, Subset Editor, and Authority 

Editor). The Print Details … option is available from the right-click context menu associated 

with the panel’s “name” element, e.g. Concept name, or Namespace Name. Selecting this option 

shows the preliminary print dialog: 

 

http://www.apelondts.org/Downloads/Documentation
http://www.apelondts.org/Downloads/Documentation
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- 

 

Enter a descriptive header string, then select one of the radio buttons to print either just the 

currently shown (expanded) nodes, or all nodes in the tree. Then click Print to open your 

operating system’s print dialog to complete the print process. 

 

The discussions in this section relate to viewing details of existing concepts, terms, and the 

creation of a new concept or term in a local namespace.  

 

G.1 View Details  
The Details panel displays as the default in the right pane of the DTS Editor Main window when 

it first opens. This panel consists of five subordinate “tab” panels, one each for viewing the 

details of concepts, terms, namespaces, subsets and authorities. You can display detailed attribute 

information for each concept, term, namespace, subset or authority that you drag from any other 

display window or panel on the Main window. The Details panel automatically selects the 

appropriate tab based on the dropped object type.  

 

The sections below describe the operation of the individual object tab panels. 

G.1.1 Batch Commit 
You will notice a small gear icon to the right of the Details Panel.   

 

 
 

This gear controls the Batch Commit function of DTS.  By default, DTS does not save changes 

you make to any concept, term, subset, namespace, or authority in the Details panel, but is in 

“Deferred Mode”, allowing you to commit several changes at once.  If you wish for changes to 

take effect immediately, you can toggle this setting to “Immediate Mode”.   
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While in Deferred Mode, changes made to items in the Details panel must be saved or discarded 

before you can leave that objects view. 

 

G.2 View Concept Details  
Concepts are normally loaded into the Concept tab by dragging and dropping from other DTS 

Editor panels. Concepts can be automatically loaded into the Details panel from the Concept 

Tree and Walker Tree panels, however, if the panel’s Click to Edit option is enabled,. See the 

descriptions of these panels for more information on Click to Edit.  

 

In the following illustration, the concept Accidental hemorrhage during medical care 

(finding), from a SNOMED CT Ontylog namespace, was clicked or dragged from the Concept 

Tree tab into the Details > Concept panel. The attributes are expanded for view. 

 

 
 

When you expand all, or selected attributes for view, the Concept/Term Details panel retains 

those tree settings for the next concept displayed in the view. Only those attributes that were 

expanded for the previous concept are “auto-expanded” for the new concept in the view.  

G.2.1 Configure Concept/Terms Details Panel View 
To select which attributes will display if there is a concept in the Details > Concept panel, right 

click the name of the concept you dragged into the panel, then click Configure View.  
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The Configure Details View window displays, listing the attribute view options available when a 

concept is displayed in the panel. 

 

 
 

To add / remove an attribute from the detail display, select the checkbox adjacent to that attribute 

to add / remove the check mark. If you are dealing with namespaces which have a large attribute 

limit, increase the default Attribute Limit of 100 to a higher setting, i.e., 1000. If you do not want 

to see any attribute you can decrease the default Attribute Limit of 100 to 0. 

 

Click OK when finished. Your display configuration is retained for later DTS sessions. 
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G.2.2 Navigate to Other Concepts or Terms from Displayed Detail  
On the Details panel Concept tab you can navigate to (and display attribute details for) another 

concept or term from the current attribute detail view. [or drag the namespace object] 

 

To display detail attributes for a concept, click or drag a concept and Details panel Concept tab. 

The Details panel Concept tab display refreshes, referencing attributes for the selected connect.  

 

 

Drag and drop other concepts linked to the main concept to the white portion of the Details panel 

Concept tab to easily navigate to, and display details for, a concept or term within the same or 

another namespace. 

 

 

 

For any displayed concept or term, you can navigate to those concepts or terms referenced in the 

displayed details (associations, inverse associations, roles, inverse roles, concepts or terms 

referenced as superconcepts, subconcepts, synonyms).   

G.2.3 View Subsets in Which a Concept Resides 
In addition to listing a concept’s attributes in the Details panel Concept tab, you have the option 

to list all subsets in which the concept in the view is included. Confirm that the Subsets option is 

checked in the Configure Details View window. 
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If the concept is included in one or more subsets, a Subsets heading is added to the Details panel 

Concept tab view and each subset in which the concept is included is listed. 

 

 
 

If a subset is modified so that the concept in the view no longer is included in the subset, that 

subset is removed from the listing.  

G.2.4 View Details Panel History Using Forward and Back Buttons  
For your reference, a history is provided of the concepts and/or terms that were displayed 

previously in the same instance of the Details panel. Each of the panel tabs – Concept, Term, 

Namespace, Subset and Authority maintain their own history. Use the Forward and Back 

buttons to navigate through concepts and terms that you viewed or edited earlier.  
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For example, if you are viewing a concept or term in the Details panel, then subsequently drag a 

different concept or term into the panel for view or edit, the Back button becomes enabled. Note 

the illustration. 

 

 

 
 

Click the Back button to review the concept that displayed in the panel previously (i.e., the 

concept in the Details panel’s concept or term history). The view always reflects the current 

Configure Details View settings.  

 

As soon as you click the Back button, the Forward button becomes enabled.  

 

Click the Forward button repeatedly to redisplay the concept or term you dragged into the 

Details panel most recently. The button becomes disabled (grayed out) when the most recent 

concept is displayed.  

 

The displayed history reflects the latest version of a concept or term. If a concept or term is 

updated after it was put in the history, the latest version of the concept or term is displayed when 

you click the Forward and Back buttons. 

 

The Details panel history is available only for the current connection instance. The Details panel 

history will be reset when you disconnect from the DTS Editor. 
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G.3 Add a New Concept/Term to a Local Namespace 

G.3.1 Create the New Concept 
Follow this procedure to add a new concept or term to an established local namespace.  

 

1. To create a new concept in a namespace, click New in the Details panel Concept tab in 

the right panel of the DTS Main window.  

 

 
 

2. The Create New Concept window displays. 

 

 
 

3. Enter the name of the new concept in the Name field. 

4. From the Namespace field dropdown list, select the local namespace to which the new 

concept will be added (only local, writable namespaces are listed).  

5. Click OK to add the concept or term to the selected namespace. The new concept name 

displays in the Details panel Concept tab, and references the namespace in which you 

created it. To cancel the addition of the concept or term to the namespace, click Cancel.  

 

 
 

6. The Create New Concept window closes. 

7. Normally, the Concept Code and ID are assigned to the new concept automatically by 

the DTS Server. Users can, on the other hand, associate a custom-written 

ConceptTermInitializer to a Namespace to have explicit control over these assignments. 

See the discussion of the Configuration Options panel for more information. Note that 

each concept name, code and ID is tracked so that if the concept is deleted at a later time, 
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that concept name, code or ID is prevented from being reassigned to another new 

concept.  

 

 

G.3.2 Change the Name of a Concept 
You can change the name of an existing concept only if the namespace is writable. 

1. Make sure the concept you want to modify displays in the Details panel Concept tab. 

Right-click on the concept name. 

2. On the displayed option list, click Rename. The Rename Concept window displays, 

referencing the existing concept name. 

 

 
 

3. Enter a New Name for the concept, and click OK. This name must not be used by any 

other concept in the namespace. 

 

 
 

4. If the concept you want to rename is in a writable namespace, the new name displays 

immediately in the Details panel Concept tab. The namespace is updated with the new 

concept name.  
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G.3.3 Change the Status of a Concept 
You can change the status of an existing concept only if the namespace is writable. 

1. Make sure the concept you want to modify displays in the Details panel Concept tab. 

Right click on the Status line and then click Update Status…. 

 

 
 

2. The Update Concept/Term Status window displays. 

 

 
 

3. Select the desired new Status: Active, Inactive, or Deleted, from the dropdown and click 

OK.  

4. The concept will redisplay with the updated Status. 

G.3.4 Copy a Concept 
You also have the option of copying, or cloning a concept in a Local read-write Namespace.  All 

updates or modifications you’ve made to the concept must be saved before this can be done. 

 

To copy a concept, right click on the Concept Name and select “Copy”. 
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Next, give the new copy of the concept a name.  You’ll notice that as you type the name, the 

Name value in the display below is automatically updated.  You can then select any and all 

attributes from the source concept to be included in the copy.  This allows the user to customize 

how much of the concept’s details to copy.  If you check the Concept Name, all attributes 

underneath the tree will be selected as well.  Once you’ve made your selections, click “Copy” to 

complete the clone process. 

 
After you click “Copy”, the new concept will appear in the details panel, with highlights to 

indicate which properties were copied from the source concept.  You must then Save the concept 

to finalize the modifications. 
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If the original concept was a Root concept, you will then receive a message asking if you wish 

the copy to also be a root concept.  Make your selection to continue. 

 
 

Selecting “Yes” will add the concept to the root of the Tree View, and will be visible one the 

Tree View is refreshed. 

 
 

G.4 Permanently Delete a Concept/Term from a Local Namespace 
For most modeling projects, concepts (and terms) are never truly deleted. They are given a 

Deleted Status (as described above) in the Working namespace version in order to maintain full 

history of the modeling activity. Sometimes, however, usually for testing or demonstration 

purposes, it is help to be able to permanently delete a concept or term. Permanent delete is only 

permitted on unpublished concepts and terms. 

 

Note: Permanently deleted concept and terms are completely removed from the DTS 

Knowledgebase and cannot be recovered. 

 

Follow this procedure to permanently delete a concept from an established local namespace.  

 

1. Make sure the concept you want to permanently delete is displayed in the Details panel 

Concept tab. Right-click on the concept name. 
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2. On the displayed option list, click Delete …. The Confirm Operation window displays, 

referencing the existing concept name. The window will also display any attributes that 

would be affected by the deleting the concept. 

 

 
 

3. Click OK to permanently delete the concept or Cancel to terminate the operation. 

G.5 Add a Synonym to a Concept 
Use one of the following methods to add a synonym (with an association type established as 

local content in a local namespace) between concepts or terms in a subscription namespace. The 

synonymous term can exist in the same namespace as the concept, or in a different namespace. A 

synonym always pairs a concept with a synonymous term (never a concept with a concept, or a 

term with a term).  

 

If you are creating a synonymous term as local content for a concept in a subscription 

namespace, the association type you select must be created already in the current local 

namespace; the resulting new synonym will be written to the current local namespace as well.  

 

You have the option of defining a new character string as the synonymous term, and linking that 

term to a concept.  

G.5.1 Create a Synonym  
Follow this procedure to link a synonymous term to a concept by right clicking on the new 

concept name in the Details panel Concept tab. 

 

1. If the new concept is displayed in the Details panel Concept tab, either right-click on the 

concept name.  Select Add Synonym from the displayed options. If the concept already 

has Synonyms, you can also right-click on the Synonyms folder name and Select Add 

Synonym.  If you have two windows up, displaying concepts and terms, you can also 

Ctrl+drag one term to the target concept to bring up the same “Add Synonym” window. 

 

 

Note: To add a synonym to an existing concept, drag the concept from another displayed 

window or panel and drop it on the Details panel Concept tab. Right-click on the concept 

name, then select Add Synonym from the displayed options. 
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1. The New Synonym window displays. The concept from the Details panel Concept tab 

displays automatically in the Concept field. 

2. If you click the Synonym Type button, you have the option of filtering the association 

types that are available from the Synonym Type field dropdown list by creating a pre-

defined, filtered list of types.  

 

 
 

3. You can Add / Remove associations from the Synonym Type field dropdown list. When 

you attempt to select an association type from the Synonym Type field dropdown list, or 

select an alternate association type, only the pre-selected association types will be 

included in the list.  

 

Click Cancel to exit without filtering the list.  
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4. If you are creating a synonymous term for a concept in a subscription or local namespace, 

only association types from the current local namespace are listed (alphabetically) in 

the Synonym Type dropdown field, and only those association types that represent 

connections between concepts and synonymous terms (Concept to Term Association); 

select the appropriate association type. A new (synonymous) association between the 

concept and the term you select will be written to the local namespace where the 

association type was created. Refer to the Association Types discussions.  

5. You can drag and drop a term from another window or click the Create New Term button 

to create a new synonymous term to associate to the concept. 

 

 
 

6. The Create New Term windows displays. Enter the Term Name and select the 

Namespace. Click OK. 
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7. In the event multiple synonyms exist for a specific concept, you can designate that one of 

the synonyms Is Preferred. On the New Synonym window, click the Is Preferred field 

checkbox to designate this synonym as the preferred synonym. This synonym will be 

referenced as Preferred when you expand the Synonyms folder on the Details panel 

Concept tab panel. 

 

 
 

8. Click OK on the New Synonym window to add the synonym to the current local 

namespace. If the synonym were added to a concept in a subscription namespace, in the 

Details panel Concept tab, the synonym displays in italics (to indicate that it is 

subscription content that was written to a local namespace).  
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G.5.2 Edit a Synonym 
Follow this procedure to modify an existing synonym for a concept. You can modify an existing 

synonym for a concept in a subscription namespace, but only if the association type exists in a 

local namespace (i.e., the synonym is content in a local namespace, and is listed in italics). 

 

1. To edit a synonym for an existing concept, drag the concept from another displayed 

window or panel and drop it on the Details panel Concept tab. If the new concept is 

displayed in the Details panel Concept tab, right-click on the concept name and select 

Modify Synonym from the displayed options. You can also double-click on the 

Synonym name to open the Modify Synonym window. 

 

 
 

2. The Modify Synonym floating window displays, referencing the concept and the 

synonymous term, as well as the namespace in which each resides. 

 

 
 

3. Make the desired edits, then click OK to update the appropriate namespace(s). 

G.5.3 Delete a Synonym 
Follow this procedure to delete an existing synonym for a concept that was created as content in 

a local namespace. 
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1. To delete a synonym for an existing concept, drag the concept from another displayed 

window or panel and drop it on the Details panel Concept tab. If the new concept is 

displayed in the Details panel Concept tab, right-click on the concept name. Select Delete 

Synonym from the displayed options.  

 

 
 

2. The Confirm Operation floating window displays, referencing the concept and the 

synonymous term, as well as the namespace in which each resides. 

 

 
 

3. Click OK to delete the synonym from the local namespace where it resides. Click Cancel 

to ignore the deletion and close the window. 

 

G.6 Add a Property to a Concept or Term 
Follow this procedure to create a new property (as local content in the current local namespace) 

for a concept or term that resides in a subscription namespace. 

 

1. Drag the concept/term for which you want to add a property into the Concept/Term 

Details panel. Right-click on the concept/term name on the Concept/Term Details panel, 

or the Properties fodder name if it is visible, then select Add Property from the 

displayed options.  
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2. The Add Property window displays. 

 

 
 

The concept/term from the Details panel displays automatically in the Source field.   

 

3. A property type is a pre-established identifier that defines the property. From the 

Property Type field dropdown list, select a property definition to be assigned to the 

concept or term. If the Concept/Term is from a subscription namespace, the Property 

Type dropdown list includes only property types created in the current local namespace, 

listed alphabetically.  
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If the Concept/Term was created in a local namespace, the Property Type list includes 

property types created in the current local namespace, but only if the Concept/Term also 

was created in the current local namespace. If the concept/term was not created in the 

current local namespace, the Property Type field dropdown list will be empty.  

 

4. You have the option of filtering the property types and qualifier types that are available 

from the Property Type field dropdown list by creating a pre-defined, filtered list of 

property types. When you attempt to select a property type from the Property Type field 

dropdown list, or select an alternate property type, only the pre-selected types will be 

included in the list. 

 

 
 

5. You can Add / Remove property types from the available Property Type field dropdown 

lists. When you attempt to select a property type from the Property Type field dropdown 

list, only the pre-selected property types will be included in the list. 

Click Cancel to exit without filtering the list.  

 

 
 

6. For the property definition (type) assigned to this concept or term, specify the property 

value in the Property Value text area. This area accommodates the entry of large amounts 

of text, as well as formatted text (e.g., paragraphs, bulleted items, etc.). A single concept 
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or term can have multiple occurrences of the same property type, each with a separate, 

unique value. All Property values may contain up to 4,000 characters and the first 255 

characters are automatically indexed 

 

 
 

7. For each property you may specify an established qualifier type and value; these provide 

additional detail regarding the nature of a concept or term property (e.g., Current). From 

the Qualifier Type field dropdown list, select the qualifier to assign to this property. The 

list includes only those property qualifier types that were created in the same local 

namespace where the selected property type was created. 

 

8. You have the option of filtering the qualifier types that are available from the Qualifier 

Type field dropdown list by creating a pre-defined, filtered list of types. When you 

attempt to select a qualifier type from the Qualifier Type field dropdown list, or select an 

alternate Qualifier type, only the pre-selected qualifier types will be included in the list.  

 

 
 

9. You can Add / Remove property types from the available Property Type field dropdown 

lists. When you attempt to select a property type from the Property Type field dropdown 

list, only the pre-selected property types will be included in the list. 

Click Cancel to exit without filtering the list. 
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10. For the property qualifier (type) you selected for this concept or term, specify the 

qualifier value in the Qualifier Value field. For each property you can create multiple 

occurrences of the same qualifier type, each with a separate, unique value.  

 

Click Add after you specify the Qualifier Type and Qualifier Value; both are added to the 

area in the lower portion of the window. Note the illustration. 

 

 
 

To remove an individual qualifier type/value combination from the property, highlight the 

appropriate line in the display area and click Remove. To clear all displayed qualifier 
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type/value combinations, click Clear. Click OK on the Add Property window to add the 

property to the current local namespace. When you expand the Properties folder for the 

concept on the Concept/Term Details panel, the property displays in italics (to indicate that it 

is subscription content that was written to a local namespace). Click Cancel to ignore the 

new property. 

G.6.1 Edit a Property 
Follow this procedure to view and/or edit a property that was created in a local namespace for a 

concept or term in a subscription namespace.  

 

1. Drag the concept/term containing the property you want to view or edit from another 

panel and drop it on into the Concept/Term Details panel. Right-click on the property for 

which you want to view or edit details, then select Modify Property from the displayed 

options. You can also double-click on the property name to open the Modify Property 

window. (Properties created as local content display in italics; the Modify Property 

option is available for these properties only.)  

 

 
 

2. The Modify Property window displays. 
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3. Make the desired edits, then click OK to update the appropriate namespace(s).  

G.6.2 Delete a Property 
Follow this procedure to delete an existing property from a concept, if the property was written 

to a local, writable namespace. 

 

1. Drag the concept/term containing the property you want to delete into the Details panel 

Concept tab and expand the Properties to display existing properties for the 

concept/term. 

 

2. Right-click on the property you want to delete, then select Delete Property from the 

displayed options. Note that the Delete Property option is not available if the displayed 

concept exists in a namespace that is not writable.  
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3. A delete confirmation window similar to the following displays.  

 

 
 

4. Click OK to delete the concept/term property from the concept in the local namespace. 

Click Cancel to ignore the deletion 

G.6.3 Use a URL as a Property Value 
 

The DTS Editor provides special handling of a property whose value is a URL (Universal 

Resource Locator). If a property value begins with “http://” or “https://”, the property’s right-

click menu includes an Open URL Target item (see below). Selecting this item opens the URL 

in the client’s default browser. 
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G.7 Add an Association to a Concept or Term 
Use the following method to add an association (with an association type established as local 

content in a local namespace) between concepts or terms in a local or subscription namespace. 

The association can be between concepts or terms within one namespace, or across different 

namespaces. 

G.7.1 Create an Association 
Follow this procedure to add an association definition and target concept value to the new 

concept by right clicking on the new concept name in the Details panel Concept tab. 

 

2. Either right-click on the concept/term name on the Concept/Term Details panel, or the 

Associations folder name if it is visible, then select Add Association from the displayed 

options.  If you have two windows up, displaying concepts, you can also Ctrl+drag one 

concept to the other to bring up the same “Add Association” window. 

 

 
 

3. The Add Association window displays. 
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4. The From concept/term from the Details panel displays automatically in the From 

Concept/Term field, establishing the From portion of the From/To association between 

concepts or terms. The namespace in which the From concept resides displays in 

brackets.  

 

5. From the Association Type field dropdown list, select the type of association (e.g., 

Related To, Parent Of) you are creating between the concepts or terms. Association 

types from the current local namespace are listed alphabetically. Refer to the Association 

Types discussions. 

 

If you click the Association Type button, you have the option of filtering the association 

types that are available from the Association Type field dropdown list by creating a pre-

defined, filtered list of types.  

 

  
 

6. You can Add / Remove associations from the Association Type field dropdown list. 

When you attempt to select an association type from the Association Type field dropdown 

list, or select an alternate association type, only the pre-selected association types will be 

included in the list.  

Click Cancel to exit without filtering the list.  
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7. From another displayed panel or window, drag the target concept/term in the association 

in the To Concept/Term dropdown field. The namespace in which the To concept resides 

displays in brackets to the right of the field.  

 

 
 

8. For each association you can add one or more qualifiers, each of which consists of an 

established qualifier type and value. Qualifiers provide additional detail regarding the 

nature of a concept or term association (e.g., Usually).  

 

You have the option of filtering the qualifier types that are available from the Qualifier 

Type field dropdown list by creating a pre-defined, filtered list of types. When you 

attempt to select a qualifier type from the Qualifier Type field dropdown list, or select an 

alternate Qualifier type, only the pre-selected qualifier types will be included in the list.  
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9. You can Add / Remove Association types from the available Association Type field 

dropdown lists. When you attempt to select an association type from the Association Type 

field dropdown list, only the pre-selected property types will be included in the list. 

Click Cancel to exit without filtering the list. 

 

 
 

10. From the Qualifier Type field dropdown list, select a qualifier type to assign to this 

association, if available. The list includes only those association qualifier types that were 

created in the same local namespace where the selected Association Type was created. 

The namespace in which the qualifier type was created displays in brackets.   

 

11. For the qualifier (type) you selected for this association, specify the qualifier value in the 

Qualifier Value field. For each association you can create multiple qualifiers of different 

types, or create occurrences of the same qualifier type, each with a separate value.  

 

12. Click Add after you specify the Qualifier Type and Qualifier Value; both are added to the 

display area in the lower portion of the window (see the illustration).  
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To remove an individual qualifier type/value combination from the association, highlight 

the appropriate line in the display area and click Remove. To clear all displayed qualifier 

type/value combinations, click Clear.  

 

13. Click OK on the Add Association window to add the association. 

G.7.2 View and Edit an Existing Association 
Follow this procedure to view or edit an association definition and target concept value for a 

concept by right clicking on the concept name in the Concept/Term Details panel. 

 

1. Drag the from concept/term in the from/to relationship you want to view into the Details 

panel Concept tab and expand the Associations to display existing associations for the 

concept. 

 

 
 

2. Right-click on the association for which you want to view or edit details, then select 

Modify Association from the displayed options. The Modify Association window 

displays. You can also double-click on the desired association name to open the Modify 

Association window. 
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3. Make the desired edits, then click OK to update the appropriate namespace(s).  

G.7.3 Delete an Association 
Follow this procedure to delete an association that exists between concepts or terms within a 

namespace, or across namespaces. The association type for the association you want to delete 

must exist in a local namespace in order for you to delete the association.  

 

1. Drag the from concept/term in the from/to relationship you want to view into the Details 

panel Concept tab and expand the Associations to display existing associations for the 

concept. 

2. Right-click on the association you want to delete (in a subscription namespace, the 

association should be in italics) then select Delete Association from the displayed 

options.  
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3. A delete confirmation window displays.  

 

 
 

4. Click OK to delete the concept/term association from the local namespace to which it 

was written originally. Click Cancel to ignore the deletion. 

 

G.8 View Term Details  
The Term tab (see example below) shows the name and attributes associated with a Term. Terms 

can be viewed by dragging a term node from other panels such as the Search panel or from a 

Synonym node from the Details Concept tab panel and dropping it into the Details panel. 

Creation and edit actions for Terms are very similar to those for Concepts. See the View 

Concepts Details section above for information on these options.  
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G.9 View Namespace Details  
The Namespace tab (see example below) shows the name and attributes associated with a 

Namespace. Namespaces can be viewed by dragging a namespace node from other panels such 

as the Tree panel or Concept Walker panel dropping it into the Details panel. Click to Edit also 

supports automatic namespace loading from the Tree panel. Right click on the namespace name 

to select from the Configure View and Print Details menu options. For Subscription 

Namespaces, the content license can be viewed at any time via the Namespace tab. Right-click 

on the License node and select the Show License menu option. If the namespace is writable, the 

Rename and Add Property options are available from the namespace name popup, and the 

Read-Only/Read/Write and Authority nodes are editable. Namespace and Version Properties 

can also be added for writable namespaces. See the View Concepts Details section above for 

information on these options. 
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One unique feature of the Namespace tab (also available in the Namespace Editor panel) is the 

ability to add root concepts to a Thesaurus namespace. A root is a concept that has no parents 

and appears at the “top” of the namespace hierarchy in the Tree and Concept Walker panels. 

Previous to DTS V4.0, namespace roots were identified by the presence of specific Term 

attributes. While this previous specification process is still supported, the new method is highly 

recommended as it does not require the creation of separate attributes. To create a root, first be 

sure that the namespace has a concept association type named “Parent Of”. This association type 

must be present in order to create a root. Then, right click on the Roots node (see example 

above) for the desired namespace in the Details Namespace tab panel (or the Namespace Editor) 

and select Add Root. Note that roots are versioned (are under a Version node) and only those in 

the Working version of a namespace are editable. The Add Namespace Root panel is shown. 

 

.  

Drop the desired root concept (from any other Editor panel such as the Search panel) into the 

panel and click Add Concept as Root.  

 

A root can be removed by right clicking on the root’s node and selecting Delete Root. A 

confirmation dialog is shown.  

 

G.10 View Subset Details  
The Subset tab (see example below) shows the name and attributes associated with a Subset. 

Subsets can be viewed by dragging a subset node from the Subset Editor panel and dropping it 

into the Details panel. Right click on the subset name to select from the Configure View, Print 

Details, Rename and Add Property menu options. Properties can be added to the Subset itself 

or to Subset Versions. See the View Concepts Details section above for information on these 

options. 

 

This panel is replicated in the standalone Subset Editor panel. For information on creating and 

modifying the subset expression, see the Subset Editor section below. 

 



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 185  

  

 

 

G.11 View Authority Details  
The Authority tab (see example below) shows the description and attributes associated with an 

Authority. Authorities can be viewed by dragging an authority node from the Namespace Editor 

Panel or Details Namespace tab panel and dropping it into the Details panel. Right click on the 

authority description to select from the Configure View, Print Details and Add Property menu 

options. See the View Concepts Details section above for information on these options. 
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H. Subset Editor 
The DTS Subset Editor allows you to create and maintain custom subsets of concepts in DTS 

namespaces. The Subset Editor is available from the DTS Editor Tools menu or the toolbar. 

Click Subset Editor in the Tools menu, or the Open Subset Editor icon  in the DTS Editor 

Main window toolbar. The Subset Editor floating window displays.  

 

A subset is an arbitrary collection of concepts. A subset may represent concepts that share a 

specific set of attributes, have a specific status, or simply are commonly used in a well-defined 

context. A subset may include only a few concepts or many concepts. The term value-set is an 

alternate name for subset. The concepts in a subset may be derived from one or more than one 

namespace, or they can be defined by their participation in other subsets. In a subset of an 

Ontylog Extension namespace, for example, subset concepts can include those from both the 

local (i.e., extension) namespace and the linked Ontylog subscription namespace.  

A very common use case for a subset is to restrict concept searches to a specific clinical domain 

or context. You also may create a subset for export to external applications (e.g., for import and 

use in spreadsheets or pick lists, or in an underlying terminology database for an EMR system).  

The following discussion provides an introduction to Subset Editor and Subset Expression Editor 

functionalities. 

 

H.1 Subset Editor Panel 
To create, edit or delete a subset, you must open the Subset Editor panel. Here, you can search 

for and select existing subsets. You then can view and, if permitted, edit, the contents of the 

selected subset, create new subsets, and select subsets for deletion. The configuration menu now 

includes History ToolTip items. If selected, the Subset Created/Modified dates and associated 

username are displayed in ToolTips. 

H.1.1 Search For and View Subsets Using Subset List Window 
Using the Subset Editor panel, you can search for all existing subsets, or for subsets that 

incorporate a selected namespace or selected subset. You also can enter criteria to search for 

subsets whose names match a specified text string.  

The results of your search will be shown in the Subset List panel. The name of each subset is 

shown, along with its Size (number of concepts), its Locality (Local or Subscription), and 

whether the subset is Current (has recently been built). Note that the subset Size reflects the 

concept count at the time of the last subset Build. When the subset expression (see below) is 

changed (and saved), the subset will no longer be marked as Current. The Size, however, will not 

be updated until the subset is rebuilt. 

To search for subsets, select one of the Filter By options, complete any associated field, and 

press Search: 

 

All  All Subsets will be shown in the list 

Name  Subsets whose names match the pattern in the entry field will be displayed. 

Simple wildcards, e.g., “Subset*”, are supported. 
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Namespace All subsets that include Namespace Filters naming the selected namespace 

will be displayed. 

Subset All subsets that include Subset Filters naming the selected subset will be 

displayed. 

Property All subsets that include Property Filters naming the selected 

 Property will be displayed. 

Version   

Property All subsets that include Version Property Filters naming the 

                        selected Version Property will be displayed. 

The table displaying the Subset Editor parameters may be also be exported. The export respects 

any filters currently in use by the Subset Editor. To export the contents displayed in the upper 

table view, click the Export button. Select Clipboard to copy the contents to your clipboard in 

order to transfer the data to other desktop applications. Select File to export the data as a locally 

saved .csv file. 

Click on any line in the Subset List to fill the Subset Details panel. From this panel, you can view 

all the details of the subset, including the subset expression, modify subset attributes including 

the expression (if permitted), or delete the subset. 

 

Note: Subset export can be performed by the Export Module and/or Terminology Query 

Language (TQL) plug-ins.  

H.1.2 Create a Subset 
To create a Subset using the Subset Editor panel, click on the New button.  
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This will bring up the New Subset area where you can enter the name, ID, description, Authority 

and Profile for your subset. Clicking the Authority button will open an instance of the Authority 

Editor if you wish to add a new Authority. 

 

Clicking on the Profile field lets you specify whether you want the Subset initialized with a pre-

defined set of Subset Attribute Types. These types are defined in a subset Profile object. If no 

Profile is desired, just leave the selection to  - None -; otherwise, select a Profile name from the 

dropdown. If you wish to add a new Profile (or review the details of any Profile), click the 

Profile button.   
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Subset Profiles are very similar to Namespace Profiles; in the Subset Profile Editor defining 

attribute types are simply limited to those appropriate to subsets rather than namespaces. See the 

Namespace Profile View and Maintenance section above for complete information on creating 

and managing profiles. 

 

H.1.3 Publish a Subset 
To publish a Subset using the Subset Editor panel, select the desired Subset then click on the 

Publish button. 
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In order to publish your subset, the subset must have been built with the current subset 

expression. If you have not built your subset expression before publishing, an error message will 

remind you to do so. 

 

 
 

For more information on subset expressions, see Save to an Existing Subset Expression and 

Build a Subset Concept Hierarchy. 

 

Once you have built the subset expression, you are ready to publish! When you click on the 

Publish button, the Publish Version window will pop up which allows you to give the subset 

version a name.  
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After you click the Publish button, accepting the version name you have entered, a confirmation 

window will pop up. This pop up notifies you that once you publish the version, it will become 

read-only; you will only be able to make changes to the new working version of the subset.  

 

 
 

By confirming this, the subset version will be created. 

 

 
 

When you return to the Subset Editor panel, subset version information will be viewable. Along 

with subset version name and the published date, you also have the option to expand the 

Expression. 

 



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 192  

  

 

H.1.4 Delete a Subset 
Follow this procedure to delete an existing subset. 

 

1. When the results of your subset search display in the Subsets list, click the subset you 

want to delete. The option buttons (New, Delete, Expr, Publish, and Close) become 

enabled as appropriate for the Permissions in your User Profile. 
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2. Click Delete. The Delete Subset confirmation window displays. 

 

 
 

3. Click OK to confirm deletion of the subset. Click Cancel to ignore the deletion. The 

Status Bar indicates deletion progress, and when deletion is completed. 
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H.1.5 Building Subsets 
To build Subsets using the Subset Editor panel, click on the Build button. This will open the 

Build Subsets panel. 

 

 
 

To select subsets to build, click in the Build column to the left of the Subset Name. Subsets can 

also be selected or unselected in batch using the following buttons: 

 

Select All   All Subsets in the list will be selected. 

Unselect All    All Subsets in the list will be unselected. 

Select Current  All Current Subsets in the list will be selected. Current Subsets are 

Subsets that have not had any modifications since it was last built. 

Select NonCurrent All NonCurrent Subsets in the list will be selected. NonCurrent 

Subsets are Subsets that have been modified since it was last built. 

Once the desired Subsets have been selected, click on the Build button. A popup will appear 

asking to confirm the number of Subsets being built. Click OK to continue and build all selected 

Subsets. Click Cancel to return to the Build Subsets Panel without building any subsets. 
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After selecting Build, a status bar will indicate the progress.  

 

 
 

A popup will appear when all subsets have been built. Click OK to confirm.  

 

 
 

H.2 Editing the Subset Expression – the Subset Expression Editor Panel 
A subset expression defines the hierarchy of criteria by which concepts will be selected for the 

subset from existing namespaces and/or subsets. You use the Subset Expression Editor panel to 

create and maintain subset expressions. 

 

The subset expression consists of filters that establish the criteria for concept selection. These 

filters specify the namespaces, subsets, individual concepts, or groups of concepts based on 

concept attributes, that will be included in the subset. The filters can work in association with 

specified exclude conditions that will either exclude specific concepts from being selected, or all 

concepts that meet your exclusion criteria. For more information on subset filters, see Adding 

Subset Filters. 

 

To open your Subset Expression Editor panel, click on the Expr button in the Subset Editor 

panel, or double click on the expression value (see below). 
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In the Expression Window, there are several icons.  

 
 

 Save - use to save changes made to your Subset expression. 

 Save Subset Expression to Subset – use to save changes made to your Subset expression to 

another Subset. 

 Preview Subset – use to view results before building Subset. After previewing, you can 

modify your filters. 

 Build Subset – use to evaluate the expression and identify the subset’s constituent concepts  
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H.2.1 Modify a Saved Subset Expression 
Follow this procedure to modify the content in an existing subset by editing the subset’s 

expression. 

 

1. Open the desired Subset in the Subset Expression Editor Window (for instructions, see 

Subset Expression Editor Window). 

2. Make the desired modifications to the subset expression. For procedures on adding, 

deleting, and/or modifying expression filters, see Adding Subset Filters, Modify a Subset 

Expression Filter, and Remove a Filter from the Subset Expression. 

3. Once you have made your desired changes, you can either save the expression to the 

existing Subset, using the  (Save) button, or you can save it to another subset using 

the  (Save to Subset) button. For more information on saving, see Save to an 

Existing Subset Expression and Build a Subset Concept Hierarchy. 
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I. Subset Expression Filters 
A subset expression consists of hierarchy of subset filters. Each filter represents a criteria by 

which DTS concepts are added to, or deleted from, subset participation. Eight filters are 

available: 

 

• Namespace filter – specifies that concepts from a single namespace (or all namespaces) 

are to be included 

• Subset filter – specifies that concepts from another subset are to be included 

• Concept filter – specifies that a concept, and/or its children or descendants, are to be 

included 

• Concept name filter – specifies that concepts having a given name format are to be 

included 

• Property filter – specifies that concepts having a given property type/property value are to 

be included 

• Synonym filter - specifies that concepts having a given synonym type/synonym target 

value are to be included 

• Association filter - specifies that concepts having a given association type/association 

target value are to be included 

• Exclude filter – specifies that subordinate filters are to be interpreted as exclusions not 

inclusions. 

• Kind filter – specifies that concepts having a given kind target value are to be included. 

All filters include a Status parameter which provides additional filtering of selected Concepts 

based on their Status. An “ALL” Status value is supported to accept Concepts having any Status. 

Subset concept participation is the result of “evaluating” each filter criteria and combining the 

results of this filter with the other filters in the expression. Filters at the same hierarchy level 

represent OR (union) conditions: the results of the filters are added together. Filters subordinate 

to another filter represent AND (intersection) conditions. The subordinate filters limit subset 

participation. 

 

In the expression shown below, the subset consists of all Active concepts in SNOMED CT 

whose names contain “TEST” plus all Active concepts in SNOMED CT that have a Code in 

Source value that starts with “1”, plus all Active concepts in Triad whose names contain 

“TEST”. 
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The sections below describe the details of each filter. 

 

I.1 Add a Namespace Filter 
Follow this procedure to designate a namespace from which subset concepts will be selected. 

 

1. To add a Namespace Filter to the subset, right click on the subset root node. Click the 

Add Namespace Filter option when it displays. 

 

 
 

The Add Namespace Filter window displays. 
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Using this window you choose the specific namespace and version from which concepts 

will be selected to populate the new subset. You can also filter the selected concept set by 

concept Status.  

2. From the Namespace field dropdown list, select the namespace (Triad in the example) 

from which to select concepts for the subset. Note that if an Ontylog Extension 

namespace is listed, it is paired with the linked Ontylog Subscription namespace (e.g., 

SNOMED CT / SNOMED CT EXT). To incorporate concepts from all namespaces, 

select the – All - option in the dropdown list. All namespace filters have additional 

restrictions on subordinate filters, e.g., Concept filters are not permitted under an All 

namespace filter. See the individual filter descriptions below for further information.  

3. Next select the appropriate version of the namespace from the Version dropdown. Unless 

the Namespace Filter has specified All Namespaces, Namespace filters must be 

associated with a version. Selecting Current as the version will always result in the 

Subset being built against the most recent version of a Namespace. This field is disabled 

for All namespace filters. 

4. Finally select the desired filter Status from the Status dropdown: pick ALL, ACTIVE, 

INACTIVE or DELETED. 

5. Click OK to add the namespace filter node to the tree. The display format is <status> 

CONCEPTS FROM NAMESPACE <namespace Name:version Name>.  Note that the 

namespace filter, and all of the filters that you add subsequently, display in italics until 

you save the subset expression. 

 

 
 

Add additional namespace filters to the expression in a similar manner. A subset expression can 

include multiple namespace filters, but namespace filters can only be added to the subset root 

node and only one namespace filter for each namespace and version combination (including All), 

is permitted in a subset expression. It is permitted to have multiple namespace filters for a 

namespace as long as different versions are selected.  

I.2 Add Concept Filters to the Subset Expression 
 

A concept filter specifies that a specific concept, and/or its children or descendants, are to be 

included in a subset. A concept filter can be added to any filter except an All namespace filter. 
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I.2.1 Add Concept Filters Using Drag/Drop 
Follow this procedure to add a Concept Filter by dragging a concept (that resides in the selected 

namespace) from another displayed window or panel and dropping it into the new subset 

expression. Based on your selection from the available options, this adds the following 

concepts(s) to the new subset expression. 

• The selected concept (only), or 

• The selected concept’s children, or  

• The selected concept’s descendants, or 

• The selected concept and all of its descendant concepts 

The Concept Filter also has a Status parameter that can further filter the returned set of concepts. 

 

1. Drag the desired concept from another displayed panel or window (e.g., Tree panel, 

Search window, etc.) and drop it into the Subset Expression Editor window. The concept 

should be dropped onto the node that will be its filter’s parent. In the illustration, the 

concept PROCEDURE was dragged from the Tree panel and dropped onto the 

namespace filter node in the Subset Expression Editor window. 

 

 
 

Drop Completed displays in the Subset Expression Editor window Status Bar to 

indicate successful copy of the concept you selected. 

 

For a subset of an Ontylog Extension namespace, the concept you select for drag/drop 

can be from the linked Ontylog Subscription namespace, or from the extension 

namespace itself. For all other namespaces, the concept you select for drag/drop must be 

from the same namespace specified in the namespace filter node (Triad in this example). 

If you attempt to drag and drop a concept from a different namespace, the following 

message window displays. 
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Click OK, then drag and drop a concept from the correct namespace.  

Note: It is also possible to drag a concept directly onto the subset root node. In this case, 

a concept filter will be created under the associated namespace node. If there is no 

existing namespace node, a new namespace node will be created under the root and the 

concept filter added to this node. 

2. The default filter behavior is to include the selected concept and all of its descendant 

concepts in the subset (i.e., the default modifier is FROM ALL), and set the filter Status 

to the status of the dropped concepts. You have the option to include in the subset only 

the selected concept (without its descendants) or only the selected concept’s descendants 

(without the selected concept), or only the selected concept’s children (without the 

selected concept), and include concepts having a different Status (subject to constraints of 

the parent filter’s Status value). 

 

To change the concept filter criteria, right-click the concept you dropped into the Subset 

Expression Editor window (ACTIVE CONCEPTS FROM ALL PROCEDURE). Click 

Modify in the displayed option list.  

 

 
 

Clicking on the Modify option will open the Edit Concept Filter dialogue box. Here, you 

will be able to change the Concept you’re applying the filter against, as well as the 

Modifier.  
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3. Click the modifier ONLY to include only the selected concept in the subset. The concept 

node in the Subset Expression Editor window changes (the modifier ALL is removed) to 

reflect that only the single concept will be selected for the subset. Note the illustration. 

 

 

 

You cannot add subordinate concept filter nodes to an existing concept filter node for 

which you selected the modifier ONLY. The following message displays if you attempt 

to add a new concept filter.  

 
 

4. Click the modifier ONLY DESCENDANTS OF to include only the selected concept’s 

descendants in the subset. The concept node displayed in the Subset Expression Editor 

Panel changes to reflect that only descendants of the concept you chose will be selected 
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for the subset (ACTIVE CONCEPTS FROM ONLY DESCENDANTS OF 

PROCEDURE is shown in the illustration). 

 

 
 

If you want to add subordinate concepts to this concept name filter node, the additional 

concepts should be descendants of the concept established in that node.  

 

Finally, note that the Status dropdown in a filter editor may not be editable. Because each 

filter selects (filters) concepts from those resulting from its parent filter, it is not possible 

for a filter to select INACTIVE concepts when its parent filter specified ACTIVE 

concepts. Only if a parent filter has the ALL Status, does the child filter have the option 

to select its Status. The filter editors are aware of this dependency and set the correct 

Status according.  

 

It is possible for an existing filter’s status to be inconsistent, for example when a parent 

filter’s status is changed from ALL to ACTIVE and a child filter is already set to 

INACTIVE. In this case, the editor displays an [INCONSISTENT] marker at the end of 

the child filter description. This is simply a reminder to the user; it is not fatal. The subset 

expression can still be saved, but the child filter is essentially meaningless since no 

concepts can result from its interpretation. 

I.2.2 Create Concept Filters from Roles and Associations 
Follow this procedure to drag a role or association from another displayed window or panel (e.g., 

Concept/Term Details panel) and use the role or association value to create a concept filter in the 

subset expression. 

 

1. Drag the desired role or association from another displayed panel or window (e.g., 

Concept/Term Details panel) and drop it into the Subset Expression Editor window. You 

can add the new concept filter (based on the target concept value of the role or 

association) to the namespace node, or add it to an existing node as an additional filter.  

 

In the following illustration, the role all HAS_SUBSTANCE_MEASURED: 

CHEMICAL was dragged from the Concept/Term Details panel to the namespace filter 

node, so an ACTIVE CONCEPTS FROM ALL Chemistry Test filter was added with an 

ACTIVE Status filter. Notice that there are two “sibling” filters under the namespace 

node; concepts from that namespace which pass either of the filters are included in the 

subset. 
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In the next illustration, the role all HAS_SUBSTANCE_ MEASURED: CHEMICAL 

was dragged from the Concept/Term .Details panel to a concept filter node, so an 

ACTIVE CONCEPTS FROM ALL CHEMICAL filter was added. 

 

 
 

In the following illustration, the association Analytic_Technique: QUANTITATIVE 

ANALYSIS was dragged from the Concept/Term Details panel to the namespace filter 

node, so an ACTIVE CONCEPTS FROM ALL QUANTITATIVE_ANALYSIS filter was 

added. 
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Drop Completed displays in the Subset Expression Editor window Status Bar to 

indicate a successful copy. 

2. For each role or association you copy to the subset expression, the default is to create a 

concept filter that includes the associated concept and all of its descendant concepts in 

the subset expression (i.e., the default modifier is ALL). You have the option to include 

the concept (without its descendants) or only the concept’s descendants (without the 

selected concept), and to select a different Status. 

 

Right-click the role or association you dropped into the Subset Expression Editor window 

(the role ACTIVE CONCEPTS FROM ALL CHEMICAL is used in this example). Click 

Modify in the displayed option list.  



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 207  

  

 

 
 

When you select the Modify option, an Edit Concept Filter dialogue box will open. This 

dialogue will let you change the Concept you are filtering against, as well as the 

Modifier. 

 

 
 

Click the modifier ONLY to include only the associated concept in the filter. The filter 

node displayed in the Subset Expression Editor Panel changes (the modifier ALL is 

removed) to reflect that only the single associated concept will be selected for the subset. 



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 208  

  

 

 
 

Click the modifier ONLY DESCENDANTS OF to include only the associated concept’s 

descendants in the subset. The filter node changes to reflect that only descendants of the 

associated concept will be included in the subset (ACTIVE CONCEPTS FROM ONLY 

DESCENDANTS OF CHEMICAL is shown in the illustration). 

 

 

 

I.3 Add Concept Name Filters to the Subset Expression 

I.3.1 Create a New Concept Name Filter 
Follow this procedure to create a concept name filter for the subset expression. This filter defines 

the concept name criteria by which concepts will be selected (from the specified namespace) to 

populate the subset. 

 

1. To filter concepts selected for the subset based on matching the concepts’ names, right-

click on the desired filter node, then click Add Concept Name Filter when the option 

list displays. You can add the concept filter directly to the namespace node, as in this 

example, or add it as a subordinate filter to another existing filter node. 
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The Add Concept Name Filter window displays.  

 

 
 

2. A concept filter is comprised of the Concept Status, Filter On and Value fields (the 

criterion Operator is set to MATCHES, and is not editable). The Concept Status 

dropdown is only editable if the concept filter’s parent filter’s Status is ALL. From the 

Filter On field dropdown list, select either the CONCEPT NAME or CONCEPT 

NAME OR SYNONYM option for the filter. 

 

If you select the CONCEPT NAME option, your search term will be matched against 

only concept names in the selected namespace. If you select CONCEPT NAME OR 

SYNONYM, your search term will be matched against concept names as well as their 

synonyms in the selected namespace. 

3. In the Value field, enter the text string that will be matched against concept names (or 

concept names and synonyms) in the namespace you selected. Text string matching is 

case insensitive, and you may use wild cards (asterisk characters), as needed. 
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In the illustration, matches in the namespace will be found for any concept name or 

synonym that contains the text string TEST (in upper or lower case).  

 

 
 

4. Click OK to add the concept name filter node to the subset expression tree (the display 

format is ACTIVE CONCEPTS HAVING CONCEPT NAME OR SYNONYM 

MATCHES <concept Name>). 

 

 

 

I.4 Add a Property Filter to the Subset Expression 

I.4.1 Create a New Property Filter 
Follow this procedure to create a property filter for the subset expression. This filter defines the 

property criteria by which concepts will be selected (from the specified namespace) to populate 

the subset. 

 

1. To filter concepts selected for the subset based on matching property criteria, right-click 

on the desired filter node, then click Add Property Filter when the option list displays. 

You can add the property filter directly to the namespace node, or add it as a subordinate 

filter to another existing filter node.  

 

In the following example, the property filter is being added to the concept name filter 

node (ACTIVE CONCEPTS HAVING CONCEPT NAME OR SYNONYM MATCHING 

*TEST*).  
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The Add Property Filter window displays.  

 

 
 

2. A property filter is comprised of the Concept Status, Type Namespace, Property Type, 

Operator, and Value fields. The Concept Status dropdown is only editable if the property 

filter’s parent filter’s Status is ALL.  

 

3. From the Type Namespace field dropdown list, select the namespace in which the 

property type for this filter resides. Only concepts from the namespace that is designated 

in the ancestor namespace (or subset) filter, that also have the property type that was 

created in the namespace selected in the Type Namespace field, will be retrieved. If the 

ancestor namespace filter is an All namespace filter, an – All - option is available in the 

Type Namespace dropdown. Selection of this value means that any Property Type having 

the name given in the Property Type field, from any namespace, will be used to select 
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subset concepts. This option can be used to filter on common Property Type names such 

as Code in Source. The values in the Property Type dropdown will be the set of all 

(unique) Property Type names in the DTS Knowledgebase. 

 

4. From the Property Type field dropdown list, select the property type for this property 

filter (cpmc_code in this example). Only concepts in the ancestor namespace that have 

this property type will be retrieved for the subset.  

5. In addition to filtering the concepts’ property type in the namespace, you can establish a 

more specific filter that returns only concepts with property values that contain the text 

string you specify. From the Operator field dropdown list, select MATCHES to further 

filter retrieved namespace concepts based on the property value text you enter in the 

Value field.  

 

Select NONE from the dropdown list if you will not filter properties based on property 

value. Concepts having any instance of the property type will be added to the subset.  

6. The Value field is enabled only if you selected MATCHES in the Operator field to 

indicate you want to match a property value as well as type. Property value text string 

matching is case insensitive; you may use wild cards, as needed. 

 

Enter the text string (e.g., 321*) for the property value to be matched. The concepts 

retrieved from the namespace designated in the namespace filter must have both the 

designated property type (i.e., the property type that resides in the namespace specified in 

the Namespace field) and this property value text (in upper or lower case).  

 

 
 

7. Click OK to add the property filter node to the tree (the display format is ACTIVE 

CONCEPTS HAVING PROPERTY cpmc_code MATCHES ACTIVE <property 

Value>). Note that the color and icon of the property filter match those that represent 

properties on other displayed panels (e.g., Concept/Term Details, Concept Tree, etc.). 
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I.5 Add an Association Filter to the Subset Expression 

I.5.1 Create a New Association Filter 
Follow this procedure to create an association filter for the subset expression. This filter defines 

the association criteria by which concepts will be selected from the specified namespace(s) to 

populate the subset. 

 

1. To filter concepts selected for the subset based on matching association criteria, right-

click on the desired filter node, then click Add Association Filter when the option list 

displays. You can add the association filter directly to the namespace node, or add it as an 

additional filter to another existing filter node.  

 

In the following example, the association filter is being added to the concept name filter 

node (ACTIVE CONCEPTS HAVING CONCEPT NAME OR SYNONYM MATCHES 

*TEST*). 

 

 
 

 

The Add Association Filter window displays.  
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2. An association filter is comprised of the Concept Status, Type Namespace, Association 

Type, Operator, Concept Space and Value fields.  The Concept Status dropdown is only 

editable if the association filter’s parent filter’s Status is ALL.  

3. From the Type Namespace field dropdown list, select the namespace in which the 

association type for this filter resides. Only concepts from the namespace that is 

designated in the ancestor namespace (or subset) filter, that also have the association type 

that was created in the namespace selected in the Type Namespace field, will be retrieved. 

If the ancestor namespace filter is an All namespace filter, an – All - option is available in 

the Type Namespace dropdown. Selection of this value means that any Association Type 

having the name given in the Association Type field, from any namespace, will be used to 

select subset concepts. This option can be used to filter on common Association Type 

names such as Maps To. The values in the Association Type dropdown will be the set of 

all (unique) Association Type names in the DTS Knowledgebase.  

4. From the Association Type field dropdown list, select the association type for this 

association filter (Analytic_Technique in this example). Only association types from the 

namespace selected in the Namespace field are listed and only concepts in the ancestor 

namespace that have this association type will be retrieved for the subset.  

5. In addition to filtering the concepts’ association type in the namespace, you can establish 

a more specific filter that returns only concepts with association values that match the 

target concept you specify. From the Operator field dropdown list, select MATCHES to 

further filter retrieved namespace concepts based on the association target you enter in 

the Concept Space and Value field. Select NONE from the dropdown list if you will not 

filter concept associations based on an association value. 

6. The Concept Space field (and the following Value field) are enabled only if you selected 

MATCHES in the Operator field to indicate you want to match an association value as 
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well as the designated association type. From the Concept Space field dropdown list, 

select the target (i.e., to) namespace in the association for this filter.  

7. The Value field is enabled only if you selected MATCHES in the Operator field to 

indicate you want to match an association target concept name as well as the designated 

association type. The text string matching for the association value is case insensitive; 

you may use wild cards, as needed. 

 

Enter the text string (e.g., *HEPA*) for the association value to be matched. The 

resulting subset will include concepts on which the selected association type exists, the 

namespace of the association’s target concept is from the Concept Space namespace, and 

the name of the association’s target concept matches the Value text (in either upper or 

lower case).  

 

 
 

8. Click OK to add the association filter node to the tree (the display format is ACTIVE 

CONCEPTS HAVING ASSOCIATION Associated_Diagnosis MATCHES ACTIVE 

<association Value>[Target Concept Space]). Note that the color and icon of the 

association filter match those that represent associations on other displayed panels (e.g., 

Concept/Term Details, Concept Tree, etc.). 
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I.6 Add a Synonym Filter to the Subset Expression 

I.6.1 Create a New Synonym Filter 
Follow this procedure to create a synonym filter for the subset expression; the procedure is 

similar to the one you follow to create an association filter. The synonym filter defines the 

criteria by which concepts or synonyms will be selected from the specified namespace(s) to 

populate the subset. 

 

1. To filter concepts selected for the subset based on matching synonym criteria, right-click 

on the desired filter node, then click Add Synonym Filter when the option list displays. 

You can add the synonym filter directly to the namespace node, or add it as an additional 

filter to another existing filter node. 

 

In the following example, the synonym filter is being added to the concept name filter 

node (ACTIVE CONCEPTS HAVING CONCEPT NAME OR SYNONYM MATCHES 

*pelvic*).  

 

 
 

The Add Synonym Filter window displays.  
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2. A synonym filter is comprised of the Concept Status, Type Namespace, Synonym Type, 

Operator, Term Space and Value fields.  The Concept Status dropdown is only editable if 

the association filter’s parent filter’s Status is ALL.  

3. From the Type Namespace field dropdown list, select the namespace in which the 

synonym’s association type resides. Only concepts from the namespace that is designated 

in the ancestor namespace (or subset) filter, that also have the synonym association type 

that was created in the namespace selected in the Type Namespace field, will be retrieved. 

If the ancestor namespace filter is an All namespace filter, an - All - option is available in 

the Type Namespace dropdown. Selection of this value means that any Synonym Type 

having the name given in the Synonym Type field, from any namespace, will be used to 

select subset concepts. This option can be used to filter on common Synonym Type 

names such as Synonym. The values in the Synonym Type dropdown will be the set of all 

(unique) Synonym Type names in the DTS Knowledgebase.  

4. From the Synonym Type field dropdown list, select the association type for the synonym 

for which you are creating a filter (Entry Term in the illustration above). Only 

association types from the namespace in the Namespace field are listed, and only those 

that represent a connection between concepts and synonymous terms. Only concepts in 

the ancestor namespace that have this synonym association type will be retrieved for the 

subset.  

5. In addition to filtering the concepts’ association type in the namespace, you can establish 

a more specific filter that returns only concepts that have synonym associations of the 

selected type and also have the target term you specify. From the Operator field 

dropdown list, select MATCHING to further filter retrieved namespace concepts based 

on the synonym target you enter in the Term Space and Value field. Select NONE from 

the dropdown list if you will not filter synonymous associations based on the synonyms’ 

value. 
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6. The Term Space field (and the following Value field) are enabled only if you selected 

MATCHES in the Operator field to indicate you want to match an association value as 

well as the designated association type. From the Term Space field dropdown list, select 

the target (i.e., to) namespace in the synonym association for this filter. The Value field is 

enabled only if you selected MATCHING in the Operator field to indicate you want to 

match a synonym target Term name as well as the designated synonym association type 

for the synonym. The text string matching for the synonym value is case insensitive; you 

may use wild cards, as needed. 

 

Enter the text string (e.g., *cellulitis*) for the synonym value to be matched. The 

resulting subset will include concepts on which the selected synonym association type 

exists, the namespace of the synonym’s target term is from the Term Space namespace, 

and the name of the synonym’s target term matches the Value text (in either upper or 

lower case).  

 

 
 

7. Click OK to add the synonym filter node to the tree (the display format is 

<status>CONCEPTS HAVING SYNONYM Preferred Name MATCHES ACTIVE 

<association Value> [Target Term Space]). Note that the color and icon of the synonym 

filter match those that represent synonyms on other displayed panels (e.g., Concept/Term 

Details, Concept Tree). 
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I.7 Add a Subset Filter to a Namespace Filter 
A Subset Filter adds another subset’s concepts to the subset being defined. For this example, we 

will add a DTS4 Subset as a Subset Filter to DTS4 Concepts.  

 

1. With the subset root highlighted, right click to view the additional options. Click on the 

Add Subset Filter option. 

 
 

2. This will open the Add Subset Filter window where you will be able to choose which 

Subset you want to add as the filter, which version of the Subset should be used, and 

the desired status of included concepts. 

 

 
 

3. For this example, we will choose the DTS4 Subset for our Subset Filter, use the 

Working Version and select ACTIVE for Status. 

 

 
 

While Subset Filters are typically added to the subset root node, they can be added as 

subordinate filters on any other filter. 
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I.8 Add an Exclude Condition Filter to a Subset Expression Filter 
You can define an exclude condition node on any node in the expression tree (except for the root 

node, e.g., DTS4 Subset). Note that you can add an exclude condition to a concept filter only if 

the concept has a modifier other than ONLY. 

 

1. To add an exclude condition to a node, right-click on the specific node (ACTIVE 

CONCEPTS HAVING CONCEPT NAME OR SYNONYM MATCHES *TEST* in the 

example), then click Add Exclude Condition when the option list displays. 

 

 
 

The EXCLUDE condition displays for the node you selected. Note that it is not necessary 

to specify a status for an exclude filter. An exclude condition itself does not perform any 

filtering of selected concepts. 

 

 
 

2. You can exclude individual concepts by dragging one or more concepts from other 

displayed windows or panels and dropping the concept(s) onto the EXCLUDE condition 

for the appropriate node. See Add Concept Filters Using Drag and Drop above.  

In the following illustration, three concepts were dragged from the Tree panel and 

dropped onto the EXCLUDE condition. 
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Based on this illustration, all concepts with names or synonymous terms that include 

TEST (i.e., all concepts selected based on the concept filter ACTIVE CONCEPTS 

HAVING CONCEPT NAME OR SYNONYM MATCHES *TEST*) will be selected for 

the subset except for the three concepts dropped onto the EXCLUDE condition (as well 

as the descendants of the three concepts). 

 

The default behavior of the drop is to specify each selected concept and all of its 

descendant concepts (i.e., the default modifier is ALL). For concept filters subordinate to 

an exclude filter, this would exclude from the subset the selected concept and its 

descendants. 

 

You have the option to specify in the concept filter only the selected concept (without its 

descendants), only the selected concept’s children (without the selected concept) or only 

each selected concept’s descendants (without the selected concept). Right-click the 

concept you dropped into the Subset Expression Editor window, then click Change 

Modifier to in the displayed option list to change the modifier. These changes determine 

which set of concepts will be excluded from the subset.  

 

To add other filters to the EXCLUDE condition, right-click on the displayed EXCLUDE 

condition. When the option list displays, select the filter you want to add).  
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In the example, a property filter is being added for the EXCLUDE condition.  

The Add Property Filter window displays. 

 

 
 

Follow the steps described in the Add Property Filter section above to adjust the filter 

parameters to your needs. 

 

I.9 Modify a Subset Expression Filter 
Follow this procedure if you want to modify an existing subset expression filter. The modify 

option is available on all filters, including Namespace and Subset filters, however, only the 

version may be modified on the latter two. 

 



DTS 4: Editor Users Guide 

  

© 2023 Apelon, Inc. Hingham Massachusetts 

Page | 223  

  

1. To modify a filter, right-click on the existing filter node that you want to edit (a property 

filter is selected for edit in the example below; modification of other filters is similar). 

Click Modify when the option list displays. 

 

 
 

The Modify Property Filter window displays. Adjust the filter parameters as desired and 

click OK to save. 

 

 
 

I.10 Remove a Filter from the Subset Expression  
You can remove an individual unwanted filter by right clicking it, then clicking Remove in the 

displayed option list.  
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The unwanted filter is removed from the expression, as shown by the strikethrough. Before you 

save or build your subset, you have the opportunity to Restore Expression Filter Additions. 

 

 
 

I.11 Restore Expression Filter Additions 
If you have removed a filter by accident, you can right click on the deleted filter, indicated by the 

strikethrough font, and click Restore. 
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You can only restore a filter that has been created or modified in the current Subset Expression 

Editor session before the expression is saved or built. The save and build operations permanently 

delete removed filters. 

 

I.12 Preview Subset Expression Results 
Before you save the new expression, you can preview which concepts will be chosen from the 

selected namespace based on the expression criteria you have entered so far.  

 

1. Click the Preview Subset icon on the Subset Expression Editor window to list concepts 

that will be included in the subset. Note that you cannot preview a subset expression that 

includes only a namespace filter; the Preview Subset icon is enabled only if at least one 

additional filter is included in the expression. 

 

 
 

The Status Bar indicates subset preview creation progress. 

 

The Preview of Subset window then displays the concepts selected based on the 

expression criteria. 
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The number of concepts selected based on the current expression criteria is indicated (74 

in the illustration); up to 1,000 concepts are displayed in the Preview window. The 

display order of the preview concepts is determined by the value of the Sort By field 

dropdown. If this value is Name, the list is sorted first by concept name, then by 

namespace name. If the value is Namespace, then the primary sort is by namespace 

name, then by concept name. The Sort By value is saved in the DTS Editor configuration 

file and applies across all Preview of Subset instances. You can resize the Preview of 

Subset window, as desired (this size setting is retained for future sessions). 

2. Click Close after viewing the preview results. Based on the preview results, you may 

want to modify one or more expression filters, delete filters, or add additional filters. 

Note the additional filter being added to the illustrated expression. 
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The new filter is added to the expression in the Subset Expression Editor window.  

 

 
 

3. Click the Preview Subset icon again to view the revised concept selection. Note that as a 

result of the additional filter that was added, a more select set of concepts was returned 

for the subset. 

 

 
 

4. If your expression includes a concept filter stating that all descendants of the concept be 

selected for the subset, the descendant concepts are reflected in the Preview of Subset 

window.  
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In the illustration, the concept HORMONE and all of its descendants are included in the 

Preview of Subset window list. 

 

 
 

5. The Preview Subset window includes a Compare button which can display the 

differences between the preview results from the current (unsaved) modified expression, 

and the results of the current, saved, version of the expression. Click Compare to 

indicate the differences between the two versions. 
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The left pane of the Comparison window reflects the version of the subset based on the 

(unsaved) expression criteria modifications you just made. The center pane lists all 

concepts (in green) that will be added to the subset if you save the expression 

modifications. The right pane lists the concepts (in blue) that will be deleted from the 

subset if you save the expression modifications.  

 

The number of concepts in each list (Concepts, Added, Removed) is indicated in the 

header for the pane; up to 1000 concepts can be listed in each pane. You can resize the 

Comparison window, as well as the panes within, as needed.  

 

Click Close when you finish viewing. When the Subset Expression Editor window redisplays, 

you can make the desired expression criteria edits based on your views of the Preview of Subset 

window and Comparison window. 

 

I.13 Save to an Existing Subset Expression and Build a Subset Concept 
Hierarchy 

After you preview, and are satisfied with, the results of the new subset expression, you have two 

options. If you Save the expression, the Subset is updated with the new expression.  

 

 
 

The Status Bar indicates the progress of the update, and also indicates when the update is 

completed. After the expression is updated all edits are finalized; modified expression filters no 
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longer display in italics and removed filters are permanently deleted, indicating that this is a 

saved expression. 

 

 
 

While the Save Subset function updates the database with the modified expression, it does not 

update the concept contents and build the subset concept hierarchy (based on the expression 

selection criteria). Creation of the subset concepts and hierarchy may require considerably more 

time than the save of the expression.  

 

A separate Build Subset option is provided that allows you to populate (Build) the subset 

concepts at a later time. The Subset Build function is discussed next.  

I.13.1 Build a New Subset Based on Expression Criteria  

Click the Subset Expression Editor Window Build Subset icon  to create the subset – and 

for subsets of Ontylog namespaces, build the subset concept hierarchy – based on the expression 

criteria. For a new (i.e., unsaved) subset expression, or an existing expression that has been 

modified, you can click Build Subset to save the new/modified subset expression, create/update 

the subset contents, and build the subset hierarchy (there is no need to select Save Subset first).  

 

 
 

Note that you cannot build a subset for an expression that includes only a namespace or subset 

filter. The Build Subset icon is enabled only if at least one additional filter in addition to the 

namespace or subset filter is included in the expression. 

 

The Status Bar indicates build progress, and also indicates when the subset build is completed. 

When the build process is finished, the filters in the expression no longer display edit decoration 

(italics and strikethrough), indicating that this is a saved expression. 
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If you attempt to close the Subset Expression Editor window without either saving the expression 

criteria or building the subset based on that criteria, the following window displays.  

 

 

 

If you click OK, the Subset Expression Editor Window closes, no subset is created, no hierarchy 

is built, and the new subset expression criteria is not saved. 

 

Click Cancel, then click the Build Subset icon on the Subset Expression Editor window to 

initiate the new concept hierarchy build. 
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J. The Module Manager 
 

The DTS Module Manager enables the loading, updating, and removal of DTS Editor User 

Modules with minimal user intervention. Direct file manipulation is not required.  

 

The Module Manager accesses current User Module information from an Internet-accessible 

Module Folder. The folder also contains installation kits for all available User Modules. Module 

information is displayed in the Module Manager panel, and Module actions (Add, Update, and 

Remove) can be specified. These actions are performed on the next DTS Editor restart.  

 

This Module Folder is typically maintained by Apelon on behalf of all DTS installations, but 

organizations can create and maintain their own Module folder in order to limit Module 

availability or add organization-specific Modules. See the Maintaining a Module Manager 

Facility guide for further information.  

 

The Module Manager is available from the DTS Editor Options menu. The following sections 

describe operation of the Module Manager and Module Update panels.  

 

 
 

J.1 Module Manager Panel 
 

Selecting the Module Manager item in the Options menu opens the Module Manager floating 

panel. The panel combines information from the Internet Module Information File, which 

contains descriptions of all available Modules, with installed Module data, to produce the 

Module Configuration area on the left of the panel. This area shows each known Module in the 

Module column, the installed version of the Module, if any, in the Current Version column, 

and the most recent version of the Module in the Latest Version column.  
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Selecting a Module line in the Module Configuration area fills the Module Info area on the 

right. This area gives summary descriptions of all versions of the selected Module. Information 

on previous versions can be shown by selecting the version name from the Version dropdown, 

but only the most recent version is available for download. 
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Selecting a Module line also enables the Module Action buttons. Pressing one of these buttons 

specifies an action to be performed on the Module. Only actions available on the selected 

Module are enabled. 

 

• Press Add to add a new Module to the DTS Editor. 

• Press Update to update an existing Module to its latest version. 

• Press Remove to remove the Module from the DTS Editor. 

• Press Clear to clear any pending Module actions and return the panel to its original state. 

Any selected action is shown in the Action cell of the Module line. 

 
The final feature of the Module Manager panel is the Preferences area at the bottom of the 

panel. Checking the Perform scan on every Connect box causes a load and analysis of the 

Module Information File on every Editor Knowledgebase Connect operation. If any new 

Modules or Module updates are available, an information dialog is shown after a successful 

connection: 

 

 
 

 
 

After all desired Module actions have been selected, press Save to persist the requests in the 

Editor configuration file.  The requested Module actions are NOT performed at this time, 

however. For technical reasons, Module changes can only be made on Editor restart. The 

selected actions are saved in the DTS Editor configuration file for execution at the next start-up. 

When the Editor is restarted, the Module Update panel (see below) is displayed that lists the 

actions and shows their progress of the actions.  Before a restart, the Module Manager panel can 

be re-opened and the actions adjusted as desired. 

 

J.2 Module Update Panel 
 

The Module Update panel is shown when the DTS Editor is started, and Module actions are 

pending. The panel lists the saved Module actions to be taken.  

 

As each action is performed, the panel shows the steps being taken For an Add or Update action, 

for example, the steps are downloading and installing. 
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After all actions have been performed, a summary message, including any errors encountered, is 

shown. Successful actions are removed from the Module Update property in the DTS Editor 

configuration file, while any actions resulting in errors are maintained. Subsequent to the update, 

the Module Manager panel can be reopened and the actions revised. 
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K. Appendix A: Custom Initialization of Concepts and Terms 
 

K.1 Introduction 
When Concepts and Terms are created in the DTS Editor, only the Concept Name (prompted by 

the New Concept/Term Dialog) and the Concept Code and Concept Id (generated by the DTS 

Server) are populated. The value of the Concept Id is the next integer in the Namespace’s 

Concept sequence (this sequence generator can be accessed programmatically, see DTS 

Sequence APIs below). The Concept Code is the same integer, prefixed by “C” for Concepts or 

“T” for Terms, e.g. “C12”, T13”. 

 

It is possible to modify these default assignments, and add additional Concept/Term attributes, 

by registering a DTSConceptTermInitializer on the Namespace. A 

DTSConceptTermInitialzer is a Java class that is called whenever a new Concept or Term is 

about to be added to the DTS Knowledgebase by the DTS Editor. The specific sequence of 

events is: 

1. User requests a new Concept/Term from a Details Panel. 

2. The Concept/Term name is received from the New Concept/Term Dialog. 

3. A DTSConceptTermInitializer is called if registered on the new object’s Namespace. 

The initializer can populate any attribute on the Concept/Term. 

4. The new Concept/Term object is sent to the server for addition to the Knowledgebase. 

To create a DTSConceptTermInitializer, you must write and compile a Java class that extends 

DTSConceptTermInitializer and place it in the DTS classpath; the lib\modules folder is 

recommended. The class can also be bundled in a jar if desired. Then register the class in the 

DTS Editor Configuration panel available from Options| Configuration Options in 

the Editor menu bar. The sections below describe details for each of these steps. 

 

K.2 Preparing a DTSConceptTermInitializer 
A DTSConceptTermInitializer is a class that extends the base class 

com.apelon.apps.dts.editor.modules.DTSConceptTermInitializer. The 

user initializer class must reside in the com.apelon.modules.dts.editor.config 

package, have an argumentless constructor and implement four methods: 

• void register(int nsid)  Called when the initializer is registered on a 

Namespace. The argument is the Id of the Namespace. Although a given initializer class 

can be registered on multiple Namespaces, a new class instance is created for each 

registration. The register method is called immediately after the Namespace’s 

initializer instance is constructed and may be used to setup any required instance 

variables. 

• DTSConcept initializeConcept(DTSConcept con)called with a new 

(empty) Concept object. Only the Concept Name and Namespace Id will be populated. 

Returns a Concept object (usually the same object as provided) populated with the 
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desired attributes. Any writable attribute (Code, Id, Primitive/Defined, Synonym, 

Property, Association, Defined Concept, Role, etc.) can be added. The DTS API can be 

used to manage Code and Id uniqueness. If the Concept Code and/or Concept id is not 

updated, the server will provide default values. 

• Term initializeTerm(Term term)called with a new (empty) Term object. 

Only the Term Name and Namespace Id will be populated. Returns a populated Term as 

described above. 

• String getDescription()called by the Configuration panel to display a 

description of the initializer (see Registering an Initializer below). This method should 

NOT depend on register previously being called.  

An example ConceptTermInitializer class is shown below. This class assigns a random Concept 

Id and sets the Concept Code and the Code in Source Property to the same value. Note that 

uniqueness of the randomized Id is checked. 

package com.apelon.modules.dts.editor.config; 

 

import 

com.apelon.apps.dts.editor.modules.DTSConceptTermInitializer; 

import com.apelon.beans.dts.plugin.DTSAppManager; 

import com.apelon.dts.client.attribute.DTSProperty; 

import com.apelon.dts.client.attribute.DTSPropertyType; 

import 

com.apelon.dts.client.concept.ConceptAttributeSetDescriptor; 

import com.apelon.dts.client.concept.DTSConcept; 

import com.apelon.dts.client.term.Term; 

 

public class CodeInSourceInitializer extends 

DTSConceptTermInitializer { 

 private final static String CIS_NAME = "Code in Source"; 

 private DTSPropertyType cisType = null; 

 public CodeInSourceInitializer() { 

  super(); 

 } 

  

//register (and verify) this namespace 
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 public void register (int nsid) throws Exception { 

  cisType = getPropertyType(CIS_NAME, nsid); 

  if (cisType==null) throw new Exception("No Property 

Type '"+CIS_NAME+"' present in Namespace."); 

 } 

  

//initialize a DTSConcept 

 public DTSConcept initializeConcept(DTSConcept con) throws 

Exception { 

  if (cisType==null) throw new Exception("No Property 

Type '"+CIS_NAME+"' present."); 

  //get the Code 

  int random; 

  while (true) { 

   random = (int)(Math.random()*100000); 

   if 

(DTSAppManager.getQuery().getDTSConceptQuery(). 

     findConceptByCode("C"+random, 

con.getNamespaceId(), 

ConceptAttributeSetDescriptor.NO_ATTRIBUTES)==null) break; 

  } 

  con.setCode("C"+random); 

  DTSProperty prop = new DTSProperty(cisType, 

""+random); 

  con.addProperty(prop); 

  return con; 

 } 

 

 //initialize a Term 

 public Term initializeTerm(Term term) throws Exception { 

  return term; 

 } 
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 //return a description of this initializer 

 public String getDescription() { 

  return "This initializer adds a Code in Source 

property."; 

 } 

 

 private DTSPropertyType getPropertyType(String name, int 

nsid) throws Exception { 

  return 

DTSAppManager.getQuery().getDTSConceptQuery().findPropertyTypeBy

Name(name, nsid); 

 }  

}  
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K.3 Registering an Initializer 
Follow the steps below to register a loaded DTSConceptTermInitializer on a Namespace. 

 

1. Select Options|Configuration Options from the Editor menu bar. The 

Configuration panel is shown: 

 

 
 

The Initializers tab lists each writable Namespace and its associated Initializer Class. 

2. To register an initializer on a Namespace, double click in the Initializer Class 

cell opposite the Namespace. The available initializers will be shown in the dropdown 

list. Select an initializer to be associated with the Namespace. Note that the initializer is 

not registered until the Save button is pressed. Mouse over any initializer name to see its 

description in a ToolTip. 

 

 
 

3. Commit the initializer changes by pressing the Save button, or exit the panel by clicking 

Close. Cancel any pending changes and return to the base assignments by pressing 

Reload. 
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K.4 DTS Sequence APIs 
In order to avoid having to test the uniqueness of id values as required in 

CodeinSourceInitializer above, the DTS API provides access to the server’s 

namespace sequence generators. These APIs enable user applications to independently retrieve, 

and/or reset, the server’s internal sequence generator values.  

int BaseLocalConceptQuery.generateNextConceptId(namespaceId, 

idCount) 

Returns the next ID in the designated namespace’s Concept sequence. This is method is 

synchronized on the server, so that the operation is “atomic” across invocations. 

idCount is the number by which the sequence is incremented after the return (usually 

1).  

int BaseLocalConceptQuery.generateNextTermId(namespaceId, 

idCount)  

Returns the next ID in the designated namespace’s Term sequence. This is method is 

synchronized on the server, so that the operation is “atomic” across invocations. 

idCount is the number by which the sequence is incremented after the return (usually 

1).  

For further information on the DTS sequence APIs, see the DTS API Javadoc.  
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L. Appendix B: Length Limitations for DTS 4 Attribute Values 

L.1 Overview 
The values users create in the DTS 4 Editor have length (character) limitations. Attributes such 

as Concepts, Terms, Properties, etc. all have value length limitations. Below is a table illustrating 

these DTS 4 value length limitations for each attribute.  

 

 

Attribute Value Length Limitation* 

Concept Name 749 characters 

Term Name 749 characters 

Namespace Name 255 characters 

Authority Name 255 characters 

Subset Name 255 characters 

Validator Name 255 characters 

Property Types2 4000 characters 

Qualifier Types3 255 characters 

Namespace Code 32 characters 

IDs1 Positive integer range from 0 to 65535 

Type Names2,3,4,5 255 characters 

 
1IDs include: [Namespace] ID, [Subset] ID, [Authority] ID 
 

2Property Type Names include: Concept [Property], Term [Property], Namespace [Property], 

[Namespace] Version [Property], Subset [Property], [Subset] Version [Property], Authority 

[Property] 

 
3Qualifier Type Names include: Concept Property [Qualifier], Term Property [Qualifier], 

Concept Association [Qualifier], Term Association [Qualifier], Namespace Property [Qualifier], 

[Namespace] Version Property [Qualifier], Subset Property [Qualifier], [Subset] Version 

Property [Qualifier], Authority Property [Qualifier] 

 
4Association Type Names include: Concepts [Association], Concept with Synonymous Term 

(Synonym) [Association], Terms [Association] 

 
5Other Type Names include: Kind, Role Type 

 

* NOTE: Character length limit may be less if one or more UTF-8 character is larger than the 

typical 1 byte. 


